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ABOUT THIS USER’S GUIDE

This user’s guide is designed as a reference to the PowerCommand� Software for Windows  ver-
sion 6.0. This guide provides basic instruction on how to install, setup and use PCW. This software is
subject to change, which may not be reflected in this manual. In cases where this manual and the
software conflict on features or operation methods, the software will take precedence. No part of this
document may be reproduced or transmitted in any form or by any means, electronic or mechanical,
for any purpose, without express written permission of Cummins Power Generation.

SOFTWARE REGISTRATION

To help us support you, please fill out and return the software registration form included in the soft-
ware package.

SERVICE AND SUPPORT

If you are having a problem with the software, write down what you can about the problem before
calling in. Also, determine whether the problem can be repeated. Have the software version available
(this can found in the Help−About window). Contact your nearest Cummins distributor for assis-
tance.

For the name of the nearest Cummins distributor, in the United States or Canada, call
1.800.888.6626, international customers should call 763.574.5000.

If assistance is not available from your nearest distributor, contact the Cummins Solution Center at
877.377.4357 (outside the toll-free area 812.377.4357).

You may also reach us at the following address:

Cummins Power Generation
1400 73rd Ave. N.E.
Minneapolis, MN  55432

� 2007 Cummins Power Generation. All rights reserved.

Cummins is a registered trademark of Cummins Inc.

PowerCommand is a registered trademark of Cummins Inc.

Windows is a registered trademark of Microsoft.
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CUMMINS POWER GENERATION POWERCOMMAND® SOFTWARE LICENSE
AGREEMENT

By breaking the seal on the PowerCommand diskette envelope, you indicate your acceptance of the
terms of this Agreement. If you do not accept the terms of this Agreement, you may return within 5 busi-
ness days of your purchase the entire contents of this kit to the Cummins distributor from which it was
purchased for a complete refund.

RECITALS:
WHEREAS, Onan d/b/a Cummins Power Generation (hereinafter ”CPG”) and Licensee desire to establish a
relationship pursuant to which Licensee will obtain certain rights from CPG with respect to the Licensed Soft-
ware, and CPG will provide certain information and updates to Licensee, all for the mutual benefit of CPG and
Licensee; THEREFORE, in consideration of the above premise and the mutual covenants contained herein,
CPG and Licensee agree as follows:

1.   License Grant and Restrictions
a. CPG hereby grants to Licensee a non−exclusive, non−transferable and non−sublicensable license to pos-

sess and use one copy of the Licensed Software contained in this package in machine−readable form to
monitor and control power generation systems manufactured or sold by CPG. The Licensed Software is
specifically licensed for use in a single facility of Licensee for its intended purpose, and it may not be
sublicensed, sold, or otherwise distributed. The license for Licensed Software is subject to the following
terms and conditions.

b. Licensee may load each copy of the Licensed Software and the “Security Key ” files provided by CPG
onto a single computer as required to use the Licensed Software for its intended purpose. Licensee may
make a single backup or archival copy of the Licensed Software in machine−readable form, provided
that Licensee affixes to the backup or archival copy any copyright and trademark notice, serial number
and any other legend of ownership contained on the original disk from which the archival copy was
made.

c. Licensee agrees to use the Licensed Software, and any updates to the Licensed Software, in strict accor-
dance with CPG’s published service practices and/or product warranty guidelines for the sole purpose of
monitoring and controlling power generation systems manufactured or sold by CPG.

d. Licensee acknowledges that CPG may, at its option and at no cost to the Licensee, provide updates to the
Licensed Software so that the most current version of the Licensed Software is used to monitor and con-
trol power generation systems. CPG may also offer for sale upgrades of the Licensed Software which the
Licensee is under no obligation to purchase.

e. All rights relating to the Licensed Software not specifically granted to Licensee pursuant to this Agree-
ment shall be retained by CPG.

f. Licensee acknowledges that the Licensed Software may include software that CPG has obtained or li-
censed from a third party, and Licensee agrees that the terms and conditions of this Agreement shall be
applicable to any such third party software. Licensee agrees to abide by any additional or modified terms
and conditions with respect to such third party software if reasonably requested in writing by CPG and/or
the third party.

2.   Markings
Licensee shall use its best efforts to preserve all copyright, trademark, ownership or other notices, legends or
markings on the Licensed Software as originally provided by CPG. In the event the Licensed Software contains
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any copyright or other message imbedded therein, Licensee shall not modify or remove such embedded mes-
sage. All copyright, trademark, ownership or other notices, legends or markings on the Licensed Software as
originally provided by CPG also shall be clearly displayed on each backup or archival copy of the Licensed
Software.

3.   Materials
The PowerCommand Installation Diskettes, Security Key Diskettes, User Manual, and any updates thereto,
constitute the entire product referred to herein as the Licensed Software unless otherwise agreed to by the par-
ties.

4. Title
Title and full ownership rights to the Licensed Software and any updates thereto, and all intellectual property
rights, including, without limitation, patent, trademark, copyright, and trade secret rights therein, shall remain
with CPG and/or its subsidiaries. CPG expressly retains all rights that it may have under U.S. or foreign laws or
international treaties relating to the Licensed Software, except for those rights expressly granted to Licensee
herein.

5. Licensee Expenses
Costs and expenses incurred by Licensee relating to any use of the Licensed Software, or any other costs not
specifically agreed upon by the parties in writing, shall be responsibility of Licensee.

6. Payment
The sales price does not include any federal, state, local or other governmental taxes, or other tariffs which may
be imposed on the sale, transportation, production, storage, or export of the Licensed Software. Any and all
such taxes and costs shall be paid by Licensee and CPG shall have no liability therefor.

7. Updates and Maintenance
a. CPG agrees to provide reasonable free Help Desk support for the current version and the latest prior ver-

sion of the Licensed Software at hours, and under terms and conditions determined solely by CPG.

b. In the event of an error or defect in the Licensed Software or periodic update thereto, CPG agrees to repair
or remedy such errors or effects which CPG deems necessary. Licensee shall, promptly upon discovery
thereof, notify CPG, in writing, of any errors or defects in the Licensed Software and/or periodic update
thereto. CPG shall use its best efforts to remedy or repair such errors or defects, devoting reasonable re-
sources to such task in view of the particular business situation and customer need.

8.   No Modification by Licensee
Licensee agrees not to translate, rearrange, reverse assemble, reverse compile, enhance, adapt, translate, alter,
modify or change in any way the Licensed Software, or any update thereto, without the prior written authoriza-
tion of CPG.

9.   Warranties
CPG warrants that the diskettes containing the Licensed Software shall be free from defects in material or
workmanship for a period of ninety (90) days from the date of delivery to Licensee. CPG also warrants that the
Licensed Software shall be delivered free of any rightful claim of infringement of any copyright, trademark,
trade secret or other proprietary right of any third party, provided that prompt notice of, and control over, such
claims is provided to CPG by Licensee. In the event of such claim, CPG may, at its sole option, defend the
claim, procure for Licensee the continued rights as described herein, modify the Licensed Software so the
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claim is avoided without reduced functionality, or refund Licensee’s sales price paid. CPG’s option shall be its
sole obligation and Licensee’s sole remedy in such event.

10.   Warranty Disclaimer
The Licensed Software and any and all updates thereto are licensed “As Is” with the exception of the warranties
specifically provided herein. CPG does not claim and does not warrant that the Licensed Software will run error
free. WITH THE EXCEPTION OF THE WARRANTIES PROVIDED HEREIN, CPG DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING THE LICENSED SOFTWARE, ITS
MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE, AND CPG WILL NOT
OTHERWISE BE LIABLE FOR INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY
KIND WHATSOEVER RESULTING FROM LICENSEE’S USE OF THE LICENSED SOFTWARE OR
FOR ANY ERROR OR DEFECT IN THE LICENSED SOFTWARE. CPG’S NET LIABILITY TO LI-
CENSEE SHALL NOT EXCEED THE TOTAL AGGREGATE PAYMENTS BY LICENSEE TO CPG WITH
RESPECT TO THE LICENSED SOFTWARE.

11.   Government Licensee
If Licensee is acquiring the Licensed Software as, or on behalf of, a unit of the United States Government, the
following provisions shall be applicable: The Government acknowledges and agrees that the Licensed Soft-
ware and documentation
relating thereto were developed at private expense and no part of the Licensed Software or documentation re-
lating thereto is in the public domain. The Government acknowledges CPG’s representation that the Licensed
Software is ”Restricted Computer Software” as that item is defined in Clause 52.227−19 of the Department of
Federal Acquisition Regulation Supplement (DFARS). The Government agrees that:

(i) if the Licensed Software is supplied to the Department of Defense (DoD), the Licensed Software is clas-
sified as “Commercial Computer Software” and the Government is acquiring only “restricted rights” in
the Licensed Software and documentation relating thereto as that term is defined in Clause
252.227−7013(c)(1) of the DFARS, and

(ii) if the Licensed Software is supplied to any unit or agency of the United States Government other than the
Department of Defense, the Government’s rights in the Licensed Software and documentation relating
thereto will be defined in Clause 52.227−19(c)(2) of the FAR.

12. Restricted Rights Legend
Use, duplication, or disclosure by the Government is subject to restrictions set forth in subparagraph (c) (1) (ii)
of the Rights in Technical Data and Computer Software clause at DFARS 252.227−7013.

13. Confidentiality

A. Licensee hereby acknowledges and agrees that the Licensed Software and periodic updates thereto con-
tain valuable information belonging to CPG that CPG considers ”confidential”. Licensee acknowledges
and agrees that the source code, object code and other information respecting the Licensed Software is
confidential information of CPG. Consistent with the purpose of this Agreement, Licensee agrees to use
its best efforts not to release, disclose or otherwise permit unauthorized access to such confidential infor-
mation. In addition to any other rights or remedies which may be available to CPG, CPG (without being
required to post any bond or other security) shall be entitled to appropriate injunctive relief against Li-
censee or its agents in the event of any breach of this section.  License acknowledges and agrees that any
unauthorized use or disclosure will cause irreparable injury to CPG and that money damages may not
provide adequate remedy.
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b. CPG and Licensee agree to clearly mark written materials as “confidential” if they are to be treated as
confidential. Verbal communications that are confidential in nature will be identified as so before, during
or immediately after the communication.

c. Licensee will use its best efforts to ensure that all individuals who are provided access to the Licensed
Software under this Agreement will observe and perform this nondisclosure covenant.

14. Termination of Agreement

a. CPG may terminate this agreement for cause in the event that Licensee becomes or is declared insolvent
or bankrupt.

b. In the event of termination of this Agreement, all rights granted by this Agreement shall revert to CPG.
Upon termination of this Agreement, Licensee will deliver to CPG all material furnished by CPG per-
taining to the Licensed
Software and will also warrant that all copies thereof have been returned to CPG or destroyed.

c. In the event of termination of this Agreement, Licensee and CPG shall remain obligated with respect to
the provisions of this Agreement relating to confidentiality of information.

15. Completeness
Licensee and CPG agree that this Agreement constitutes the complete agreement and understanding between
the parties relating to Licensed Software and updates thereto. This agreement supersedes all prior agreements,
understandings, and negotiations whether written or verbal with respect to the subject matter hereof. This
Agreement can only be modified by a written agreement signed by both parties.

16. Export Regulations
Licensee understands that the Export Administration Regulations of the Department of Commerce of the
United States may prohibit the export of the Licensed Software to certain countries and agrees to conform to
those regulations.  Licensee shall indemnify CPG against any liability or loss related to Licensee’s failure to
conform to those regulations.

17. Governing Law
This Agreement shall be governed by and construed in accordance with the laws of the State of Indiana, United
States of America and NOT the UNCISG. To the extent required in order to comply with the laws and regula-
tions of any country in which Licensed Software is distributed or used, the terms and conditions of this Agree-
ment shall be construed to most nearly effectuate the purposes of the Agreement as set forth herein. If any pro-
vision of this Agreement shall be held to be unenforceable, such holding shall not affect the enforceability of
any other provision hereof.

18. Attorney’s Fee’s
In the event of any legal action or other proceeding that is brought about to enforce this Agreement, the prevail-
ing or successful party shall be entitled to recover reasonable attorneys’ fees as well as other costs incurred in
that action or proceeding in addition to pay compensation to which it may be entitled as a result.

19. Agreement Successors and Assigns
The terms and conditions of this Agreement shall inure to the benefit of and enforceable by CPG and the suc-
cessors and assigns of CPG’s interest in this agreement and/or CPG’s ownership of the Licensed Software.

©Cummins Power Generation 2007
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1. Introduction

SYSTEM OVERVIEW

The PowerCommand® Software for Windows
(PCW) program provides local and/or remote
monitoring of generator sets, transfer switches
and related devices.

This User’s Guide covers PCW 6.0. This ver-
sion supports the protocol for two site types:

• PowerCommand Generator Set (PCC Seri-
al)

• FT-10 Network (LonWorks�)

PCW operates on an IBM−compatible PC,
with Windows 2000, Windows XP Pro or Win-
dows NT V6.0 operating systems. Refer to sec-
tion 2 for complete system requirements.

Figure 1-1 illustrates single site monitoring
setups for local and remote configurations that
do not require a network.

The PCC 3100, PCC 3200, and PCC3201 con-
trols support PCC serial communications for
monitoring without the use of an FT-10 net-
work. PCC 2100, PC-ATS, and generator sets
with a 1301 operator panel require a network
card to send remote alarms. All other devices
(DIM’s, CCM-T, CCM-G etc.) must be moni-
tored over an FT-10 network.

Note: Devices that are installed in a network
with autobinding (self-installed networks)
cannot be monitored with PCW.

LonWorks is a trademark of Echelon Corp.

PCW

Modem Modem GenSet

Remote Monitoring
PCC 3100/PCC 3200 Only

PCW
Local Monitoring

GenSetSerial Null Modem Cable

PCC Genset or PC-ATS

FIGURE 1-1. LOCAL AND REMOTE MONITORING SETUPS
THAT DO NOT REQUIRE A NETWORK
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Modem SLTA-10 FT-10 Network

GCM
(GenSet)

ATS

Remote Monitoring with multiple Network Devices

PCW + LNS

Modem GenSet

Remote Monitoring with one Network Device

PCC 2100 with Network Card

SLTA-10Modem

SLTA-10
FT-10 Network

GenSetDigital I/O Module ATS

Local Monitoring with Multiple Network Devices

PCW + LNS

PCW + LNS

Modem

FT-10 Network

Digital I/O Module

FIGURE 1-2.  TYPICAL LOCAL AND REMOTE MONITORING SETUPS
THAT REQUIRE NETWORK INSTALLATIONS

Network Applications

PCW can be used to monitor devices on an
FT-10 network channel. See Figure 1-2 for typ-
ical network installations.

NOTE: PCW does not support monitoring
of devices over a TP-78 (transceiver type)
network channel.

To monitor devices on a network, the monitor-
ing PC must have the LonWorks LNS server
version 3.1, or greater, installed. The PC also

needs an FT-10 network interface (gateway)
driver and a copy of the network site database.

The LNS server software installation and setup
procedures are described in Section 3. This
installation, along with instructions on import-
ing a network database must be performed be-
fore a network site can be created with PCW.

Note: A backup copy of the database, from
the network site to be monitored, is required
to complete the PCW setup. Contact the
network installer to obtain a copy of this da-
tabase.
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SOFTWARE FEATURES

The features available in PCW are briefly de-
scribed here, and are covered in more detail in
the sections related to these features.

Main Features:

Alarm Monitoring - Monitors for alarms
through a local and/or remote dial-in port. An-
nunciates and displays alarms as they are re-
ceived. Alarms are logged and custom reports
can be created to view alarm information for
specific devices and time periods.

Data Log - A group of predefined data points
(based on device type) can be monitored,
logged or charted on a real-time basis.

Data Points - Displays a predefined group of
data points and settings (based on device type)
in a preformatted view.

Front Panel View - Simulated view of the
front panel for PCC3200, PCC3201, PCC
3100, PCC2100, 1301 operator panels, and
PCATS (PowerCommand transfer switches).
Allows remote access to query the display me-
nus.

Summary View - Predefined tables of data
points for monitoring gensets, transfer
switches, Digital I/O Modules (DIM), Con-
trols Communication Modules (CCM-G and
CCM-T) and Annunciators (LSA). The Sum-
mary View data points are updated approxi-
mately every 10 seconds.

LonWorks FT-10 network Support - Connec-
tivity to a commissioned PowerCommand net-
work via an Echelon SLTA network adapter al-
lows local and remote monitoring of one or
more devices on the network.

Additional Features:

Strip Chart - Available from the toolbar or
Start Program menu, allows the user to display
user defined data points in a real-time strip
chart.

Compare Utility - Two user selected data
points can be monitored within one device or
between devices.

System Administration/Security - User setup
provided to limit user access. Different user
privileges depending on user access level.

Reports −  Report feature can be used to pro-
duce an Alarm or Data report. User defined de-
vices and time period.

Journal Log − Track user activities, such as
when a user connected to a site and started or
stopped a device. User activities are logged
and a custom report can be generated to display
activity for a specified time period.

Module Template Editor − Allows the user to
define and apply a template to DIM and CCM
modules.

Multiple Open Windows − Allows the user to
launch (spawn) multiple windows from within
the application.
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USER INTERFACE FEATURES

The system software operates in the Windows
graphical environment and is completely com-
patible with Windows.  You can access PCW
from the Start menu, just like your other Win-
dows applications. If you are unfamiliar with
Windows, or have questions about the Win-
dows operating system, launch the Help pro-
gram from the Start menu.

All system commands are accessible by mouse
and keyboard. Frequently used commands
have keyboard shortcuts and toolbar access.

Only commands applicable to the current ac-
tive window are enabled. All other commands
are grayed out.

Enable the system sounds on the PC for audi-
ble notification for features like alarms.

ABOUT THIS USER’S GUIDE
This User’s Guide covers software installa-
tion, setup and operation of the PCW program.
Section 1 provides an overview of this manual,
and some of the basic operating concepts and
features.
Section 2 describes the required hardware and
software and the PCW software installation
and setup procedures.
Section 3 covers additional installation and
setup steps that are unique to monitoring de-
vices in a LonWorks FT-10 network applica-
tion. This section covers the LNS server soft-
ware installation, network interface (gateway)
driver installation and steps required to import
a network site database.
Section 4 covers PCW main menu and tool bar
functions.
Section 5 covers an overview of the procedures
for using the PCW monitoring software.
Sections 6 through 15 cover PCW’s features
and toolbar functions in more detail.
Changes in the PCW operation, or differences
between the features described in this User’s
Guide and the current software release may be
found in the PCW ReadMe file.
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2.  PCW Installation and Setup

This section covers PCW version 6.0 installa-
tion procedures and setup instructions. Addi-
tional software installations and setups are re-
quired for monitoring devices on a network.

If your application involves monitoring one
or more devices on an FT−10 network, com-
plete the installation procedures in this sec-
tion, review the setup procedures, then follow
the procedures in section 3.

INSTALLATION
REQUIREMENTS

Before installing the PCW software, refer to
the following system requirements for the PC
that will be used to operate PCW.

User Background

To install and use PowerCommand Software
for Windows, you need:

• Experience using personal computers.
• Experience using Windows operating sys-

tems.

PC Requirements

The following section specifies the recom-
mended PC.

Please note that PCW version 6.0 does not sup-
port the Windows 95 operating system.

• An IBM PC or 100% compatible PC.
• 64 MB of RAM, or greater, must be up-

gradeable. (XP user’s should have 128 MB
or higher). Hard Drive of 1.5 GB or greater.

• Recommended Operating System: Micro-
soft Windows 2000, Windows XP Pro, or
Windows NT 6.0.

• Microsoft Internet Explorer version 5.5 or
higher.

• SVGA (1024x768) color display.
• Windows compatible pointing device and

101 key enhanced keyboard.
• 16X CD-ROM.
• One parallel port. One free serial commu-

nications port.
• Windows compatible printer (optional).
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PCW INSTALLATION

Failure to log on to the PC with the system
security feature enabled will prevent PCW
from installing properly. If your PC sys-
tem security is enabled and you selected
Cancel during the start up Logon, you
must restart your PC and enter the re-
quired logon information, prior to instal-
ling PCW.

Close all other programs, including the
Microsoft Office shortcut bar. Close any
programs that have been docked to the
taskbar.

During installation, pop-up messages may
be displayed behind an open window. If
the install program is not responding,
check the taskbar, or press the Alt−Tab
keys to display hidden windows. Review
and close any pop-up messages.

To install PCW software:

1. Insert the PCW CD into the PC.

2. After a short delay the program will be-
gin and launch the Install Shield Wizard.

(If the program does not autostart, select
Run from the taskbar Start menu. At the
prompt, type D:\Setup [substitute the
drive letter of the CD drive being used, in
place of D] and then click on the OK but-
ton.)

3. Click on the Start Installation button to
begin the installation. Figure 2-1.

NOTE: The installation windows in-
clude an Installation Help [F1] button
which allows for access to these in-
structions.

NOTE: If you did not install PCW
software when you installed another
PC tool (InPower Pro or InPower
Lite), the message shown in Figure
2-2 is displayed.

FIGURE 2-1.  START INSTALLATION
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FIGURE 2-2.  NOTICE OF PC TOOL
ALREADY INSTALLED

4. The install program will begin and go
through a series of checks and prepa-
ration for the installation. 

The message shown in Figure 2-3 is dis-
played if the install program detects an
earlier version of PCW. When this mes-
sage is displayed, the earlier version
must be Uninstalled. 

If an earlier version is not detected, pro-
ceed to step 5. 

If an earlier version is detected, refer

to Appendix A for instructions on re-
moving the old PCW version. Begin at
step 4, in Appendix A.

Note: You must use this PCW version
6.0 install program to remove PCW
versions 2.0 and 2.5 from powerswept
PCs.

5. At the Select Tools installation window,
click inside the checkbox next to Power-
Command for Windows, then click on
the Next button to proceed with the
installation. Figure 2-4.

FIGURE 2-3.  REMOVE PREVIOUS
VERSIONS

FIGURE 2-4. INSTALL PCW
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FIGURE 2-5.  INSTALL − DESTINATION FOLDER

6. At the Choose Destination Location win-
dow, accept the destination folder (rec-
ommended). Click on the Next button to
proceed. Figure 2-5.
Changing the destination location will
result in installing the Strip Chart and
Monitor folders in the specified location,
all other files and folders will be installed
on Drive C. 
To edit the location for the Strip Chart
and Monitor folders, click on the Browse

button to locate an existing directory and
folder location or edit the path and folder
directly in the dialog (browse dialog is
not shown).

7. At the Start Copying Files window, ac-
cept the default directory path (rec-
ommended) or click on the Back button
to edit the desired folder location. Then
click on the Next button to accept the di-
rectory settings and proceed. Figure 2-6.

FIGURE 2-6.  INSTALL − CURRENT SETTINGS
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8. At the View ReadMe File window, click
inside the View ReadMe checkbox (rec-
ommended) to select it. Click on the Next
button to proceed. Figure 2-7.

9. If View Readme was selected, use the
scroll bars to access the information that
is provided in the Readme file. Click on

the Next button when finished reviewing
this text. Figure 2-8.

10. When the PC Tools Setup Complete win-
dow is displayed, click on the Finish but-
ton to complete the installation. Figure
2-9.

Refer to the following Setup section for infor-
mation on using the Setup dialog.

FIGURE 2-7.  VIEW README FILE

FIGURE 2-8.  README FILE
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FIGURE 2-9.  INSTALLATION COMPLETE
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SETUP FEATURES

After successfully completing the installation
of PowerCommand for Windows, an initial
setup must be completed. If you attempt to use
the PCW program before the setup is com-
pleted, the message shown in Figure 2-10 is
displayed.

The Setup dialog allows the installer, or Sys-
tem Administrator, to set user preferences and
make changes to both Sites and Devices. Setup
is also used to establish remote communica-
tions settings and setup datalog preferences.

Review each of the setup procedures in this
section to become familiar with the features.
During the initial installation, make Unit of
Measure selections and click on the Next but-
ton. Click the Next button to bypass any of the
remaining setup steps that you are not certain

about. You can always return to the setup fea-
ture to make changes or additions.

A Site Setup for a network application can-
not be completed until after the network
installation steps. Instructions for creating a
Site Setup for a network application is covered
in Section 3.

The Setup feature can be accessed from the
Start menu (Start −> All Programs −> Power
Generation −> Setup). Figure 2-12 shows the
first Setup dialog.

After the initial setup is completed, the Setup
feature can also be accessed from the PCW
main window, Tools menu drop-down list.
When accessed this way, seven setup tabs are
displayed with the Unit of Measurement tab as
the default selection (see Figure 2-11). To se-
lect another feature, click on the appropriate
tab.

FIGURE 2-10. SETUP REQUIRED MESSAGE

FIGURE 2-11. SETUP TABS
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Unit of Measurement 

This feature allows selection of  a list of pre-de-
fined units of measure, based on customary re-
gional or country measures. PCW will convert
and display values according to the units of
measure selected from the System Of Mea-
surement drop-down list.

User’s can create their own list by entering a
name in the System of Measurement dialog.
To customize a setup, select individual Unit
Descriptions, by Unit Type, from drop-down
lists.

Click on the Next button to view the next setup
menu.

FIGURE 2-12. SETUP DIALOG − UNIT OF MEASURE

User Setup − System Administration

The System Administration feature (User Set-
up) allows a person using the Windows logon
(with System Administrator privileges) to es-
tablish a user profile for each user on the sys-
tem. After the initial setup, only the System
Administrator will have access to the User
Setup dialog.

Note: With PCW, using the System Admin-
istration feature requires the user to have
admin rights on the PC. Using this feature is
not recommended for most users. If you do
not have admin rights, conflicts between
Windows User Administration and PCW
User Setup can occur, preventing user ac-

cess to PCW. When this occurs, a Windows
Administrator may be required to change
the PC’s user access. The user name must
exactly match the Windows user name.

Three access levels are available as follows:

Read Only: User can connect to and monitor a
local or remote site.

Read/Write: User has full use of all PCW fea-
tures, including making adjustments.

Administrator: An Administrator has full use
of all PCW features. The administrator can
create new sites and maintain user privileges
for all users on this PC.

Click on the Next button to view the next setup
menu.
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FIGURE 2-13.  USER SETUP

Site Setup

The Site Setup dialog allows the user to Add,
Remove or edit a Site (Figure 2-14). This fea-
ture is used to setup local and remote sites.

Refer to page 2-17 for more information on
using this feature. This includes examples of
a site setup for remote communications and an
example of a local setup with a PCC 3100 de-
vice. Refer to Section 3 for information on set-
ting up a network site.

To remove a site from the Site List, select the
site and click on the Remove button. A pop-up
will be displayed to prompt you to continue
(Yes) or cancel this operation (No). Click on

the Yes button to remove the site, or click on
the No button to cancel the removal.

To add a site, click on the Add button. The
Create Site dialog is displayed. This feature is
described in the following section.

Selecting a site from the Site List enables the
edit feature.

When a site is selected, the sites protocol and
COM port can be edited. Also the Device Set-
up button is enabled. This feature allows the
user to add or remove devices. This feature is
described later in this section.

Click on the Next button to view the next setup
menu.
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FIGURE 2-14. SITE SETUP DIALOG

Communications

The Communications setup feature is used to
enable incoming calls (from remote sites) for
monitoring remote sites. The Remote Con-
nections feature is used to select the modem
that will be used for outgoing calls (to remote
sites). The Lon Network Connections feature
is used to set the phone number for local and re-
mote applications (covered in section 3).

Incoming Calls: Enable this feature by click-
ing on the Allow incoming calls checkbox.
(Check mark appears in checkbox when the
feature is enabled.)

In the Use modem combo box, select the de-
sired modem (from remote sites). Only one
modem can be selected.

Remote Connections: In the Remote Connec-
tions − Use modem combo box, select the mo-
dem to use for outgoing calls (to remote sites).
The names of all modems currently installed
on the system will be listed in the drop-down
list. The First Available selection allows the
Windows TAPI program to select an available
modem.

Click on the Next button to view the next setup
menu.
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FIGURE 2-15.  COMMUNICATIONS SETUP

Logging Setup

The Logging Setup feature is used to set the
logging path directories and preferences for
the data logging feature.

Directory: The Directory setup allows the
user to enter a directory path for logging data
The Browse button, next to the path dialog
(Figure 2-17), can be used to locate and select
the desired directory.

Settings: The Settings group is used to reserve
disk space for logging and archiving, selecting
the maximum number of active devices for
logging.

Reserving disk space (buffer) for logging data
will reserve the disk space for logging data
with PCW. The default setting is 100 MB for
the logging buffer. The minimum setting is 1
MB, and the maximum is limited by the
amount of available space on the partition.

FIGURE 2-16.  EXCEEDED DISK SPACE

If the reserve buffer setting exceeds the avail-
able disk space, a pop-up message will warn
the user that the available disk space has been
exceeded (Figure 2-16).

The number of active devices that can be
logged can be set between one and 20 devices,
the default setting is 4.

The settings can all be restored to the default
settings by clicking on the Defaults button.

Click on the Next button to view the next setup
menu.
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Browse
Button

FIGURE 2-17.  LOGGING SETUP
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Disk Space Estimator: The Disk Space Esti-
mator allows the user to enter the desired log-
ging frequency, in minutes, and then calculate
a projection of the logging space in days.

The Logging Frequency range is from 1 to 240
minutes, and the default value is 5 minutes.

After entering the Logging Frequency, click on
the Calculate button to view the Projected
Logging Space. The amount of estimated Log
Drive Space for the directory paths, specified
earlier, is also displayed. Make adjustments as
needed to assure an adequate amount of log-
ging space, then click on the Apply button to
save the changes.

Paging

The Paging setup feature is used to select au-
thorized personnel to be paged, and to set pref-
erences for the paging feature.

Paging List Setup: Subscriber names must be
added to the Subscriber Name List on the right
side of the dialog box. After each entry, click

on the Add button on the right side of the Sub-
scriber Name List.

After this list is complete, names can be added
to the Paging List. Select a name in the Sub-
scriber Name List and click on the Add button
to the right of the Paging List.

Individual names can be removed form the
Paging List or the Subscriber Name List be se-
lecting the name and clicking on the Delete
button. The entire list can be removed by click-
ing on the Clear button.

Polling Directory: Either accept the default
polling directory or else click on the Browse
button to select a new location.

Max Message Length: Enter the number of
characters that will be allowed in a message.

Max Subscribers: Enter the maximum num-
ber of subscribers per site that will be allowed
to be paged.

Click on the Next button to view the next setup
menu.

FIGURE 2-18.  PAGING SETUP
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E-mail

The E-mail setup feature is used to enter e-mail
addresses for authorized personnel and to set
preferences for the e-mail feature. A LAN or
dial-up connection is required in order to use
this feature.

The default e-mail setup screen is shown in
Figure 2-19.

1. Under Site List:, select the control that
you will be receiving e-mails from when
you are connect with PCW.

2. Under E-mail Address List:, enter the e-
mail in which you want to receive e-mails
of faults from the control (in the example
shown in Figure 2-20, it is the PCC1301).
Once the address is entered, click on the
Add button to the right of “E-mail Ad-
dress List.”

3. Click on the e-mail address (in this case,
EmailMe@Cummins.com) so it is high-
lighted. Then click on the Add button to
the right of “E-mail Address List.” The
address is now displayed in the Site E-
mail Address List (see Figure 2-21).

FIGURE 2-19.  DEFAULT E-MAIL SETUP SCREEN
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FIGURE 2-20.  E-MAIL ADDRESS LIST SETUP

FIGURE 2-21.  SITE E-MAIL ADDRESS LIST SETUP
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4. Under Mail Settings,

a. For the Senders E-mail Address,
enter an e-mail address which will
send the fault codes to the addresses
that will receive the e-mails.

b. For the SMTP Server Name or IP,
enter the IP address or Server name

that the “Sender’s E-mail Address”
originates from.

c. For the Network Connection
Type, select Use LAN or Use Dial-
Up Connection.

5. When all settings have been completed,
click on Apply and OK.

FIGURE 2-22.  COMPLETED E-MAIL ADDRESS LIST SETUP
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SITE SETUP FEATURES

This section describes the Site Setup features
available from the Site Setup dialog shown on
page 2-10.

Use the Cancel button to close any of the fol-
lowing dialogs without saving any changes
made during this session. Use the OK button to
accept the existing settings.

Create Site

When the user selects the Add button, the
Create Site dialog appears (Figure 2-23). This
dialog allows the user to select a Site Type,
Site ID, Protocol, Location and COM Port.

Use each of the dialog fields as follows:
Site Type − Use Physical for local monitoring
when using direct serial communication. Use
Network when monitoring one or more de-
vices on an FT-10 network. (Note: PCC2100
controls and PC-ATS controls require an op-
tional network module for remote communica-
tion.) Refer to Section 3 for network setup in-
structions.

Site ID − Enter a name that will be useful for
identifying the site, BLDG2 or LOCAL.

Protocol − Select goal for device applications
that are not on a network. If Network was se-
lected for the Site Type, the Protocol box is not
displayed.

Location − Use Local for local monitoring ap-
plications. Use Remote for applications that
use a modem. Note that the last dialog changes
from COM Port to Telephone Number when
Remote is selected for the Location.

COM Port: Enter the COM port on the PC that
is used to connect to the site.

Telephone Number: Enter the telephone num-
ber of the phone line connected to the modem
at the site location.

Click on the OK button to save the new site.
This establishes the port, next, setup a device
for this port.

FIGURE 2-23.  CREATE SITE DIALOG

Device Setup

The Device Setup dialog allows the user to
Add, Remove or edit a device (Figure 2-24).
Device setup is not required in network ap-
plications, refer to Section 3.

Selecting a device from the Device List allows
the user to edit the Device Name and Type.
The dialog also displays the Site Name, that
the Device is associated with.

Selecting the Add button displays the Create
Device dialog (Figure 2-25). This dialog al-
lows the user to enter a new Device ID., Device
Name and allows the user to select a Device
Type from a drop-down list.

Use each of the dialog fields as follows:
Device ID − Enter a name to identify the de-
vice.  
Device Name − Use a generic term to describe
the device (such as PCC 3100).
Device Type − Select the type from the drop-
down list that matches the device being moni-
tored. For remote applications, select PCF De-
vice, or select the device name from the list.
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FIGURE 2-24.  DEVICE SETUP DIALOG
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Currently the following device types are sup-
ported:

ATS
Consumer Device
CORE II ECS
DKHA
GCP PCS
HDCA
HDKAJ
HDKC
HMI220
HMI320
HMI211
HMI211 (MCM3320)
HQD Display
HQD (Engine Control Module)
HQD (Transfer Switch)
HQD Inverter
Marine
Marquis Premium
MCM3320
NonGCP PCS
OPPANEL
PCC1100
PCC1100 User Interface
PCC1300
PCC1300 User Interface
PCC1301
PCC1302
PCC2100
PCC2300
PCC3100
PCC3200
PCC3300
PCF Device
Raven Commercial
TS1312
TS2312

Click on the OK buttons for the Create Device
and Device Setup dialogs, then click on Apply
to save the settings. Click on OK to complete
the setup and close the Site Setup dialog.

FIGURE 2-25.  CREATE DEVICE DIALOG

Remote Site Setup Example

The following procedures describe how to set-
up PCW for remote communication.

The Setup feature is accessed from the Start
menu by clicking on the All Programs −>
Power Generation −> PCW program group.
Click on Setup, to launch the Setup dialog.

If a TAPI Error message appears, you may
be using Windows 95 or Windows 98 oper-
ating software. PCW does not support re-
mote communications with Windows 95 or
Windows 98.

In this example the user will define a new site,
then add a device for that site and apply the
changes.

1. Navigate to the Site Setup dialog in the
Setup menus (Figure 2-14). Click on the
Add button, to display the Create Site
dialog.

2. Enter the following information in the
dialog to create a new remote site:

Site Type − Select Physical from the drop
down list.

Site ID − Enter a site name; use REMO-
TEA in this example.



2-20

Protocol − Select goal as the protocol
from the drop-down list.
Location − Select Remote from the
drop-down list.
Telephone Number: Enter the telephone
number of the phone line connected to
the modem at the site location.

3. Click on the OK button to save the new
site. This establishes the port, next, setup
a device for this port.

FIGURE 2-26.  CREATE SITE DIALOG

4. Click on Remote, in the Site List, then
click on the Device Setup button to ac-
cess the Device Setup dialog. Click on
the Add button to access the Create De-
vice dialog (Figure 2-27). For remote
communication, enter the following in-
formation in the Create Device dialog:

Device ID − Enter PCCA.

Device Name −  Enter PCCA.

Device Type: Click on the drop−down
arrow, then scroll to and select pcf_dvc
or select the device name from the list.

5. Click on the OK buttons for the Create
Device and Device Setup dialogs; then
click on Apply to save the settings. Click
on OK to complete the setup and close
the Site Setup dialog.

FIGURE 2-27.  DEVICE SETUP
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FIGURE 2-28.  CREATE DEVICE DIALOG

PCC3100 Setup Example

In this example, a local site will be setup to
monitor a PCC 3100 control.

1. Launch the Setup program from the
Start menu All Programs −> Power
Generation program group.

In this example a new site will be created
specifically for connecting to a PCC
3100 control that is not on a network.

FIGURE 2-29.  PCC 3100 SITE SETUP

2. Navigate to the Site Setup dialog in the
Setup menus and then click on the Add
button, located below the Site List.
Create a new site for connecting to the
PCC 3100 control. Select the Site Type
Physical, from the drop down list. Enter
a Site ID. Selecting mon from the Proto-
col drop-down list. Select Local for the
Location and enter 1 (or the desired com
port)for the COM Port. Click on the OK
button to create the new site.

3. With PCC_3100 selected in the Site
List, click on the Device Setup button,
then click on the Add button, to create a
new device (Refer to Figure 2-28).

4. Enter a Device ID and Device Name
(Figure 2-30). Select PCC 3100, from
the Device Type drop-down list. Click on
the OK button to create the device. Click
on the Device Setup OK button to exit
the Device Setup. Click on the Apply
button to save the device setup.

FIGURE 2-30.  PCC 3100 DEVICE SETUP
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ADDING A SITE

A site can be added using the menu bar.  This
method accomplishes the same thing as Create
Site does from the Setup menus.

1. Go to Tools −> Add Site (see Figure
2-31).

2. In the Add Site dialog (see Figure 2-32),
select a Location if using a Local or Re-
mote connection.

3. Enter the COM / Telephone number that
you are using on your computer.

4. From the Products list, select the control
that you will connect to with PCW.

5. Click on the OK button.

FIGURE 2-31.  ADD SITE

FIGURE 2-32.  ADD SITE DIALOG

NETWORK SETUP

Before setting up PowerCommand for Win-
dows to be used in network applications, the
network must be set up using LonMaker for
Windows. For more information on networks
and naming limitations, refer to the FT-10 Net-
work Installation and Operation Manual
(900−0529). Then go through the following
setup procedures.

1. If the initial setup has not been com-
pleted, go to Start −> All Programs −>
Power Generation −> Setup and navi-
gate to the Setup dialog. If the initial set-
up has been completed, start the PCW
program on go to Tools −> Setup from
the menu bar and then click on the Site
Setup tab (see Figure 2-33).

2. Click on Add to open the Create Site dia-
log.

FIGURE 2-33.  SITE SETUP
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3. Fill in the following information (see
Figure 2-34).

• Site Type: Select Network from the
drop-down list.

• Network Type: Enter “LonWorks”

• Network: Select your network
name

• Site Name: Re-enter your network
name

• Location: Select Local or Remote

4. Click on the OK button.

5. From the Site Setup dialog, select the net-
work name from the Site List and click on
Device Setup (see Figure 2-35).

FIGURE 2-34.  CREATE NETWORK SITE

FIGURE 2-35.  SELECTING THE
NETWORK

6. Click on “DIM” in the Device List and
select the created template (see Figure
2-36).

7. Click on the OK button.

8. Open the Communications dialog and se-
lect the Local or Remote connection
name (see Figure 2-37).

FIGURE 2-36.  DIM SETUP
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FIGURE 2-37.  SELECTING THE
NETWORK CONNECTION NAME

9. From the Device Explorer view, double
click on the network name (see Figure
2-38).

FIGURE 2-38.  NETWORK ADDED TO
DEVICE LIST

10. Double click on DIM to view the con-
tents of the DIM folder. Data Log, Data
Points (see Figure 2-39), and Summary
View (see Figure 2-40) screens can be
viewed.

DIM relays can be activated or deacti-
vated using the PCW Summary View
screen.

FIGURE 2-39.  DATA POINTS SCREEN

FIGURE 2-40.  SUMMARY VIEW SCREEN

CCM-G and CCM-T Setup

1. Start the PCW program on go to Tools −>
Module Template Editor from the
menu bar and select either CCMG Edi-
tor or CCMT Editor (see Figure 2-41).
A blank template is displayed (see Figure
2-42).

FIGURE 2-41.  SELECTING THE CCM-G
EDITOR
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FIGURE 2-42.  BLANK CCM-G EDITOR

2. Either accept the default template or
create your own.

• To accept the default template (see
Figure 2-44), select CCM Default
from the drop-down list under
“CCMG (or CCMT) Template:”

• To create your own template, fill in
the appropriate information in the
required fields (such as shown in
Figure 2-45) and click on Save As.
The Template Name dialog is dis-
played (see Figure 2-43). Enter the
name and click on the OK button.

FIGURE 2-43.  TEMPLATE NAME

FIGURE 2-44.  DEFAULT CCM-G TEMPLATE
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FIGURE 2-45.  CUSTOM CCM-G TEMPLATE

3. Close Power Command for Windows.

4. Go to Start −> All Programs −> Power
Generation −> Setup and navigate to the
Site Setup dialog.

5. Click on Add. The Create Site dialog is
displayed.

6. Fill in the following information (see
Figure 2-46).

• Site Type: Select Network from the
drop-down list.

• Network Type: Enter “LonWorks”

• Network: Select your CCM name

• Site Name: Re-enter your CCM
name

• Location: Select Local or Remote

7. Click on the OK button.

FIGURE 2-46.  CREATE CCM SITE

8. From the Site Setup dialog, select the
CCM name from the Site List and click
on Device Setup (see Figure 2-47).

9. Click on “CCMG” in the Device List and
select the created template (see Figure
2-48).

10. Click on the OK button.



2-27

11. Open the Communications dialog and se-
lect the Local or Remote connection
name (see Figure 2-49).

12. Start Power Command for Windows and
click on the CCM network (see Figure
2-50). Alarms, Data Log, Data Points
(see Figure 2-51), and Summary View
(see Figure 2-52) screens can be viewed.

CCM relays can be activated or deacti-
vated using the PCW Summary View
screen.

FIGURE 2-47.  SELECTING THE CCM

FIGURE 2-48.  CCM SETUP

FIGURE 2-49.  SELECTING THE
NETWORK CONNECTION NAME

FIGURE 2-50.  DEVICE EXPLORER − CCM
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FIGURE 2-51.  DATA POINTS
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The Data Points screen includes information
on the following parameters.

Site ID SITE_ID
Device Name CCM
Genset
Start Status Inactive
Fault Reset Status Inactive
Shutdown Command Status Inactive
Relay Status 04 Inactive
Relay Status 05 Inactive
Relay Status 06 Inactive
Relay Status 07 Inactive
Relay Status 08 Inactive
Custom Status 01 Inactive
Custom Status 02 Inactive
Custom Status 03 Inactive
Custom Status 04 Inactive
Custom Status 05 Inactive
Custom Status 06 Inactive
Custom Status 07 Inactive
Custom Status 08 Inactive
Custom Status 09 Inactive
Custom Status 10 Inactive
Custom Status 11 Inactive
Custom Status 12 Inactive
Custom Status 13 Inactive
Custom Status 14 Inactive
Custom Status 15 Inactive
Custom Status 16 Inactive
Common Alarm Status Inactive
Low Fuel Inactive
Low Engine Temperature Inactive
Low Battery Voltage Inactive

High Battery VOltage Inactive
Fail To Start Inactive
Overspeed Inactive
High Engine Temperature Inactive
Low Oil Pressure Inactive
Pre-High Engine Temperature Inactive
Pre-Low Oil Pressure Inactive
Generator Running Inactive
Panel Switch Off Inactive
Panel Switch Run Inactive
Charger AC Failure Inactive
Low Coolant Level Inactive
Voltage L1−N 0
Voltage L2−N 0
Voltage L3−N 0
Frequency 0.0
Current L1 0
Current L2 0
Current L3 0
Power Factor 0.00000
Kilowatts 0
KVAR 0
KVA 0
Battery Voltage 0.0
Oil Pressure 0.0
Oil Temperature −273.2
Misc Temperature 1 −273.2
Misc Temperature 2 −273.2
Engine Coolant Temperature −273.2
Engine Fuel Rate 0
Engine Speed 0
Spare 1 0.00
Spare 2 0.00
Spare 3 0.00
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FIGURE 2-52.  SUMMARY VIEW

START MENU GROUP
SHORTCUTS

PCW installs Start-Menu shortcuts for the
PCW applications (Figure 2-53). The Read
Me, Setup, and Uninstall features are de-
scribed in this section. Strip Chart and Moni-
tor are described in their own sections. The
PowerCommand for Windows (PCW) pro-
gram is covered in an overview in Section 5.
RegEchDb is only accessible if an LNS server
and LonMaker are installed. The User Guides
feature provides a link to this manual. Clicking

on any one of these shortcuts launches the se-
lected application.

ReadMe File

When PCW is installed, a ReadMe file is cop-
ied to the Power Generation group. This file
contains last minute changes and instructions
for using PCW. Always review these instruc-
tions during or after the initial software instal-
lation.

Uninstall

Refer to the following section for instructions
on how to uninstall PCW.

FIGURE 2-53.  START MENU GROUP SHORTCUTS
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UNINSTALL PCW 6.0

This procedure describes how to uninstall
PCW 6.0. The Uninstall program is ac-
cessed from the PCW program group.

The uninstall program does not remove
the directory “C:\Program Files\Power
Generation”.

To uninstall PCW:

1. Click on the Start −> All Programs
menu, select Power Generation −
PCW − Uninstall.

2. The program begins and displays the
Select Tools window. Click inside the
checkbox next to PowerCommand
for Windows.  Figure 2-54. Then
click on the Next button to continue.
Use the Cancel button to stop the
uninstall program.

3. The Uninstall confirmation window
is displayed. Click on the OK button
to remove PCW from the PC. Figure
2-55.

FIGURE 2-54.  UNINSTALL PCW

FIGURE 2-55.  UNINSTALL − CONFIRMATION
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FIGURE 2-56.  UNINSTALL − COMPLETE

4. An Uninstall Complete confirmation
window is displayed to indicate that
PCW was successfully removed.

Click on the Finish button to close
this window. Figure 2-56.
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3. Network Applications

To monitor devices over an FT-10 network,
additional installation steps are required. Net-
work applications require the Echelon LNS
server to be installed on the Monitoring PC.

For monitoring a local network, the PC re-
quires a network interface (gateway) driver
installation and setup.

In all network applications the network site da-
tabase must be imported for use with PCW.
Each of these procedures are described in this
section.

Review the typical network installation draw-
ings shown in Figure 1-2. If the application
does not call for monitoring devices on a net-
work, do not perform the procedures in this
section.

A backup copy of the network site database
is required to complete the PCW setup. Con-
tact the network installer to obtain a backup
copy of the site database. This file is required
to enable PCW to create a Site for the network.

NOTE: To monitor a PCC2100 controlled
genset, a PCATS, or any device other than a
PCC3100, PCC3200, or PCC3201, an FT-10
network will be required.

The following setup steps must be completed
to setup the monitoring PC for use over an
FT-10 network.

• LNS Server Installation
• LNS Server Service pack Installation
• Gateway Driver Installation and Setup
• Dialing Configuration for Alarms
• Import the Network Site Database
• Preparing the Site Database File for PCW
• Import the Network Site Database
• Local or Remote Site Setup

LNS SERVER INSTALLATION

The PCW package for network applications
includes a support CD for the LNS server and
network gateway drivers.

This installation includes installing a service
pack (SP7) update to the LNS server. Close all
other programs, including the Microsoft Of-
fice shortcut bar. Close any programs that have
been docked to the taskbar.

To install LNS software:

1. Insert the LNS CD into the CD drive.

2. Select Run from the taskbar Start menu.

3. At the prompt, type:
D:\LNS Server\Setup.exe
(or use the drive letter of the CD drive)
and then select OK, or use the ENTER
key.
(If the setup program does not start, use
the Run dialog Browse button to locate
the LNS Server setup.exe file. Double
click on the file to start the install.)

4. Follow the on-screen prompts, if
prompted to remove any disks before re-
booting, remove any disks except the
installation CD.

5. The program will begin the setup and dis-
play a status bar showing the progress as
the LNS server files are copied to the PC.

When the installation is completed, leave the
LNS CD in the CD drive and proceed to the
SP7 service pack installation.
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To install the SP7 Service Pack:

Select Run from the the Start menu again, to
begin the service pack installation.

1. At the prompt, type:
D:\LNS3SP7.exe
(or use the drive letter of the CD drive)
and then select OK, or use the ENTER
key.
(If the setup program does not start, use
the Run dialog Browse button to locate
the service pack .exe file. Double click on
the file to start the install.)

2. The install program will extract the ser-
vice pack files and begin the installation.
At the Welcome dialog, select Next, to
install the files.

3. At the LNS Version ... Detected dialog,
select Yes, to proceed with the installa-
tion.

4. Review the license agreement and select
Yes, to accept the terms of the agreement.

5. Fill in the Name and Company informa-
tion and select Next, to proceed.

6. Accept the default destination folder by
selecting Next.

7. At the Setup Complete dialog, select Fin-
ish to restart the computer and complete
the installation.

When the service pack installation is finished,
close the Echelon LNS Utilities (if displayed)
close it and proceed to the gateway driver
installation instructions.

GATEWAY DRIVER
INSTALLATION AND SETUP

The LNS CD contains drivers for FT-10 net-
work gateway devices. Install the driver that
matches the gateway device type used with the
monitoring PC. Most applications will use ei-
ther an SLTA-10 external gateway, or a
PCLTA-20 gateway.

In this example the SLTA-10 installation and
setup will be described.

1. Use Windows explorer to locate the gate-
way driver folder for the gateway device
type used with the monitoring PC (in this
case SLTA-10). Double click on the
slta10....exe file to begin the driver
installation.

2. From the WinZip Extractor window, se-
lect Next to begin the setup.

3. From the Setup window, select Next to
view the license agreement.

4. Review the license agreement and select
Yes, to accept the terms of the agreement.

5. In the Choose Destination Location win-
dow, select Next, to use the default des-
tination (recommended).

6. In the Select Program Folder window, se-
lect Next, to create the program folder.

7. Select No to the option of accessing the
file from DOS.

8. Click on the Finish button to complete
the installation setup.
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Gateway Module Settings
Launch the SLTA Link Manager from the
Start menu (or the taskbar icon ). Click on the
Link menu and select New. Follow the instruc-
tions to setup the gateway for either local or re-
mote applications.
Local Setup: For a local network application,
enter the name and type for the link. To oper-
ate correctly, the name must be entered ex-
actly as shown.
Name: LocalSLTALON1 and  click on the
Local button, click on the Update Identifier
box to select it, then click on Next (Figure 3-1).

FIGURE 3-1.  SLTA LOCAL SETUP

Use the Serial Port drop-down arrow to select
the serial port that the SLTA is attached to on
the monitoring PC. Use the Speed drop-down
arrow to select 38400 as the communication
speed, click on Next to continue.

FIGURE 3-2.  SLTA SETUP SPEED
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Remote Setup: For a remote network applica-
tion, enter the name and type for the link, use
the following name.  To operate correctly, the
name must be entered exactly as shown. 

Name: RemoteSLTALON1 and  click on the
Remote button. Enter the network name in
single quotes. Click on the Update Identifier
box to select it, then click on Next (Figure 3-3).

FIGURE 3-3.  SLTA REMOTE SETUP

Use the Dialing Address dialog to enter the
area code (if applicable) and phone number of

the phone line that is connected to the modem
at the remote site. Skip the Configure Line set-
ting, connection speed will be set automatical-
ly. Click on the Next button and then the Fin-
ish button to complete the setup.

FIGURE 3-4.  SLTA REMOTE DIALING
ADDRESS
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FIGURE 3-5.  SLTA LINK PROPERTIES

Alarm Settings

After making the initial local or remote gate-
way settings, a Link Properties dialog box is
displayed. This feature is used to setup the
gateway for delivering alarms.

Setup the Command Line by clicking on the
Browse button. Navigate to and select the a file

named PostEchBvAlarm.exe. This file is lo-
cated in the following directory:

C:\Program files\common files\cummins
shared\power generation\

Double click on each folder, beginning with
the Program Files folder, until you reach the
PostEchBvAlarm.exe file. Double click on
(or open) this file, the directory path and file
will be added to the Command Line.

The Command Line needs to be appended with
additional instructions. Refer to Figure 3-5.
Click inside the Command Line and use the
right arrow key, to reach the end of the Com-
mand Line (or use the End key). Enter the fol-
lowing text, including spaces, enter a space be-
fore the first percent symbol:
 %id% %LINKNAME%

Click on Finish , to complete the Link Proper-
ties settings. Click on OK, to close the SLTA
Link Manager.
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FIGURE 3-6.  SLTA DIALING CONFIGURATION

Dialing Configuration for Alarms

In this step, the PC must be connected to the
SLTA-10 network interface (gateway).

This feature is used to configure the gateway
module with the phone number of the monitor-
ing site(s). Start the SLTALink Manager from
the Start menu (or the taskbar icon). Click on
the Link menu and click on Select/Action,
then select the gateway from the Link Name
list to be setup for dialing out to the monitoring
PC. Click on the gateway, and click OK.

Click on the Devices menu, select Configu-
reSLTA... . When the Configuration dialog is
displayed (Figure 3-6), click on the Dial Di-
rectories number 1 button. Enter the phone
number of the modem at the primary monitor-
ing site. Click on the Apply button to save the
change.

Repeat the Dial Directories settings to config-
ure up to four more monitoring sites. When an
alarm is sent to the first site, if it is not received
the alarm will go to the second site, and contin-
ue down the list of sites until the message is re-
ceived.
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FIGURE 3-7.  SLTA DIALING CONFIGURATION

Enabling the Monitoring PC to
Receive Remote Alarms

In this step, the SLTA Link Manager is config-
ured to enable the monitoring PC to receive re-
mote alarm messages. This is required for
monitoring remote sites when PCW is oper-
ating, but the monitoring PC is not con-
nected to the site.

Start the SLTALink Manager from the Start

menu (or the taskbar icon). Click on the Bell
shaped toolbar icon.

The Monitor Line for Dial-In dialog will be
displayed. Click on the Monitor button (Fig-
ure 3-7) to enable the monitoring PC to receive
remote alarms. Then click OK. The Bell icon
will be highlighted and the SLTA Link Manag-
er status line will display the message Monitor-
ing Line.

To disable this feature, click on the Bell icon
again and click on the Release button.
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IMPORTING THE NETWORK
SITE DATABASE

The network site backup database is created by
the network installer. The network installer
uses the LonMaker for Windows Backup fea-
ture, and the Backup Database selection.
LonMaker for Windows creates the backup
copy of the network site, as a compressed (ZIP)
file.

Note: The network name (site ID) must con-
sist of no more than seven characters. The
characters can only be upper case letters,
numbers and underscores. Use of lower case
letters, special characters and spaces will
prevent PCW from recognizing dialed-in
alarms from the site. Make sure the network
installer does not use lower case letters, spe-
cial characters, or spaces for the network
name.

Device names in network applications must
consist of no more than eight characters.
The characters can only be upper case let-
ters. Use of lower case letters, special char-

acters, numbers and spaces will prevent
PCW from recognizing the device name in
an alarm message.

The site backup database file is usually small
enough to be transferred to a floppy disk. Lo-
cate the site backup file (sitename.zip) using
Windows Explorer. Double click on the file to
launch the WinZip utility.

Extract the file to the root drive on the monitor-
ing PC (typically the C:\ drive). Click on the
Use Folder Names checkbox in the Extract
dialog (Figure 3-8), to maintain the correct di-
rectory structure.

Note: In applications where the site will be
monitored by both a local PC and a remote
PC, two unique copies of the network site
database will be required. The network site
database file names will be the same, but one
file should be identified for use on the local
PC and the other file should be identified for
use on the remote PC.

When finished extracting the file, close the
WinZip program and close Windows Explorer.

FIGURE 3-8.  EXTRACT SETTINGS
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FIGURE 3-9.  REGISTERING NETWORK SITE DATABASE

Prepare the Network Site Database
File for PCW

To make the network site database file avail-
able to PCW, a program named RegEchDB
must be run on the PC. Perform this procedure
after the network site database has been im-
ported.

1. Launch the RegEchDB program from the
Start −> All Programs −> PowerGen-
eration −> Power Command for Win-
dows folder. Click on RegEchDB to start
the program.

2. Enter the network name. Use the exact
same name as the network name pro-
vided by the network installer. (Up to
seven characters consisting of only upper
case letters, numbers and underscores.)

3. Enter the database path. Typically
C:LM\DB\network name. See example
in Figure 3-9.

4. Confirm that the Register Task button is
selected. Click on the Register button in
the lower right corner of the window.

5. When the RegEchDB program finishes, a
popup message informs the user that the
network has been successfully regis-
tered. Click on the OK button to close
this message. Figure 3-10

6. Click on the Close button, when finished
preparing (registering) the network data-
base.

FIGURE 3-10.  SITE DATABASE
INSTALLED
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SLTA-10
FT-10 Network

Genset ATS

Local Monitoring with Multiple Network Devices
PCW + LNS

Digital I/O Module

FIGURE 3-11.  TYPICAL LOCAL NETWORK MONITORING SETUP

LOCAL NETWORK SITE
SETUP EXAMPLE

The following procedures describe how to set-
up PCW for local communication.

The Setup feature is accessed from the Start
menu by clicking on the All Programs −>
Power Generation program group. Click on
Setup, to launch the Setup dialog.

In this example the user will define a new site
for a local network application.

Site Setup

Click on the Site Setup tab to access the Site
Setup dialog (Figure 2-14). Click on the Add
button, to display the Create Site dialog.

Create Site

Enter the following information in the dialog
to create a new remote site:

Site Type − Select Network from the drop
down list.

Network − Use the drop−down list and select
the name for the network to be monitored. (IF
the network name is not present in the drop-
down list, cancel the setup and return to the
section on importing the network database in
this section.)

Site Name − Enter the name as it appears in the
preceding Network name.

Location − Enter Local, from the drop down
list.

SLTA Password: This feature is typically not
used. If the SLTA has a password, enter it here
and write the password down for future use.

Click on the OK button to save the new site.
This establishes the site, in network applica-
tions it is not necessary to create devices for the
site because the devices that are at the site are
imported from the network database.

FIGURE 3-12.  CREATE SITE DIALOG
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Modem SLTA-10 FT-10 Network

GCM
(Gen-
Set)

ATS

Remote Monitoring with multiple Network DevicesPCW + LNS

Mo-
dem

Digital I/O Module

FIGURE 3-13.  TYPICAL REMOTE NETWORK MONITORING SETUP

REMOTE NETWORK SITE
SETUP EXAMPLE

The following procedures describe how to set-
up PCW for remote communication.

The Setup feature is accessed from the Start
menu by clicking on the All Programs −>
Power Generation program group. Click on
Setup, to launch the Setup dialog.

In this example the user will define a new re-
mote network site.

Site Setup

Click on the Site Setup tab to access the Site
Setup dialog (Figure 2-14). Click on the Add
button, to display the Create Site dialog.

Create Site

Enter the following information in the dialog
to create a new remote site:

Site Type − Select Network from the drop
down list.

Network − Use the drop−down list and select
the name for the network to be monitored. (IF
the network name is not present in the drop-
down list, cancel the setup and return to the
section on importing the network database in
this section.)

Site Name − Enter the name as it appears in the
preceding Network name.

Location − Enter Remote, from the drop-
down list.

Telephone Number: Enter the telephone num-
ber of the phone line connected to the modem
at the site location.

SLTA Password: This feature is typically not
used. If the SLTA has a password, enter it here.

Click on the OK button to save the new site.
This establishes the site, in network applica-
tions it is not necessary to create devices for the
site because the devices that are at the site are
imported from the network database.

FIGURE 3-14.  CREATE SITE DIALOG
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FIGURE 3-15.  NETWORK COMMUNICATION SETUP

COMMUNICATIONS SETUP
NETWORK SITE EXAMPLE

After setting up PCW for either a local or re-
mote network site, the Communications setup
needs to be completed.

The Communications setup feature is used to
enable incoming calls for remote applications
and setup remote and network connections.

Click on the Communications setup tab. En-
able the Allow incoming calls checkbox, to al-
low incoming calls (alarms). (Check mark ap-
pears in checkbox when the feature is en-
abled.)

Next, establish a Lon Network Connection for
Local or Remote, or both if you plan to make
local and remote network connections.

Local: Click on the drop-down arrow and se-
lect SLTALON1 from the list (or use
PCCLON1 if using PCC-10 card). Click on
the Apply button (Figure 3-15).

Remote: Click on the drop-down arrow and se-
lect SLTALON1 from the list (or use
PCCLON1 if using PCC-10 card). Click on
the Apply button.

Click on the OK button when finished.
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4.  PCW Basics

This section describes the main window and
user interface features.

STARTING PCW

Start PCW by selecting All Programs from
the Start menu. Click on Power Generation
and then click on PCW. The programs in the
PCW program group will be displayed. Click
on PowerCommand for Windows, from
within the PCW group, to launch the PCW
program and display the PCW Main Window
(Figure 4-1).

THE MAIN WINDOW

The main window, named Device Explorer,
includes the Menu Bar, Toolbar, Status Bar,
and the left and right window panes.

The Menu Bar contains the groups of com-
mands that are used to connect to a site and a
device, and access PCW features. A list of
menu options is available under each main
menu entry (Figure 4-2).

The PCW Menu Bar expands to display addi-
tional menu features when PCW is connected
to a device or a file.

When a Menu Bar command is grayed
(dimmed), the command is not available. You
may need to select another action (such as con-

necting to a site or device) before the grayed
command will be displayed in black type, indi-
cating that the feature is available.

• To display the list of options under a menu
entry, move the mouse pointer to the menu
name and click on the mouse button.
(Clicking refers to using the mouse select
button, typically the left button.)

• To select an option from a menu list, move
the mouse pointer to the option name and
click on it.

The Toolbar provides direct graphical inter-
face shortcuts to some of the more frequently
used menu options. Buttons on the Toolbar
represent frequently used tool functions.

When a Toolbar button is grayed (dimmed),
the shortcut to that command is not available.
You may need to select another action (such as
connecting to a site or device) before the
grayed command will be displayed in color (or
black type)—indicating that it is available.

Placing the mouse pointer on a Toolbar but-
ton, the Status Bar describes the function of
the button.  The Status Bar also shows a de-
scription of operations as they occur.

The left window pane works like Windows Ex-
plorer to navigate the directory tree. The right
window pane displays the contents (or screens)
for the item selected in the left window pane.

Menu Bar

Status Bar

Tool Bar

Right Pane Displays Contents of the Item
Selected in the Left Pane

Left Pane Used To Navigate
the Directory

FIGURE 4-1.  MAIN WINDOW
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Connect

Exit

Print

Purge Logs...

File

Disconnect

Connect

Start Genset

Stop Logging

Start Logging...

Device

Disconnect

Stop Genset

Copy Ctrl-C

Edit

Setup...

View Journal Log...

View Alarm Log...

View Data Log...

Tools

Module Template Editor

Commit pending alarm acknowledgements

DIM Editor...

CCMG Editor...

Toolbar

Stripchart

Monitor

Split

Window

Status Bar

View in Separate Window

Cascade Windows

Close All

Annunciate Alarms

Display Alarm Window

How to Use Help

About Device Explorer...

Search for Help On...    Shift-F1

Help

Help Contents...             F1

File Device Edit Tools Window Help

Device Explorer - Power Command

Save Adjustments

Refresh Parameters Ctrl+R

CCMT Editor...

Add Site

FIGURE 4-2.  MENU SYSTEM CONTENTS
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MENU DESCRIPTIONS

This section provides a brief description of the
functions performed by each of the PCW menu
commands. Some of the menus are not dis-
played until  the program is connected to a Site
or a device.

Several of the menu features have Toolbar
shortcuts (see Figure 4-3), and some directo-
ries can be opened (or connected to) by double
clicking on the item from the directory tree, in
the left window.

File

The File menu allows the user to Connect to
and Disconnect from a Site. PCW uses the
term Site to refer to a device location that is be-
ing monitored. A site can be either local or re-
mote. In network applications a single site may
consist of one or more devices. The Site setup,
(described in Section 2, includes the COM
Port that the site is connected to on the moni-
toring PC.

The File menu allows the user to Purge Log
Data that allows the user to purge old data
from the log files. There is also a Print com-
mand that allows the user to print the current
view, and there is an Exit selection, for exiting
PCW.

Device

The Device menu is used to Connect to, and
Disconnect from, a device. In order to monitor
a device and receive alarm messages from it,
PCW needs to be connected to the device.
PCW uses the term device when referring to a
controller such as the Genset control.

The Device menu can be used to Start Log-
ging and Stop Logging a preselected group of
data points for the connected device. PCW can
be used to change a few of the devices settings,
then use the Device menu to Save Adjust-
ments. (Refer to Section 8). The Device Menu
can also be used to Start or Stop a generator
set.

Edit

The Edit menu can be used to Copy one or
more data points, for use in another PCW fea-
ture like Strip Chart or Compare.

Tools

The Tools menu can be used to launch the Set-
up program for PCW. Starting this program
from within PCW will cause the program to
close all connected sites.  Or the Add a local or
remote Site feature can be used.

Tools provides a Module Template Editor for
DIM’s and CCM’s. This feature allows you to
create custom templates and edit the labels for
relays and customer inputs.

A view (or report ) can be created to look at the
information contained in the Data Log, Alarm
Log, or Journal log.

The Commit Pending Alarm Acknowledge-
ments feature allows the user to purge alarms
from the alarm log file for the connected de-
vice.

The Window menu can be used to set the PCW
user preferences by enabling or disabling the
Toolbar and Status Bar, resizing the left and
right pane with Split, and choosing to have in-
coming alarm messages annunciate and dis-
play in a pop−up window.

The right pane in PCW can be spawned into a
new window with the View in Separate Win-
dow command. Open windows can be Cas-
caded or Closed from the Window menu.

The Monitor and Strip Chart features can be
launched from the Window menu. 

The Refresh feature can be used to update all
of the data points displayed in the Value field.

Help

The Help menu commands are used to find on-
line help information. Help is also used to dis-
play PCW product and version information.
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USER INTERFACE

Frequently used commands have keyboard
shortcuts and toolbar access. Only commands
applicable to the current active window are en-
abled. All other commands are grayed out.

Keyboard Access
PCW uses standard Windows keyboard con-
ventions.

The underlined letter indicates the keyboard
selection for a given menu option. For exam-
ple, refer to the File Menu in Figure 4-3.

• To select the File menu, press and hold the
“Alt” key and type an “F” (Alt  F).

• To select a menu feature like Connect from
the File drop down menu, type a (C).

Toolbar
Some frequently used commands have toolbar
shortcut buttons. Figure 4-3 shows the Toolbar
and lists what each of the buttons represent.

Connect/Disconnect: Use to either Connect,
or Disconnect, to make or brake a connection
with a site. Availability of this tool button
toggles between the Connect and Disconnect
icon, depending on whether the user is con-
nected or disconnected.

Print Current View: Brings up a print dialog
used to print the current view.

Disconnect

Monitor

Copy Selection
 to Clipboard

Exit PCW
Help

Spawn Current View
in New Window

Print Current View

Connect

Remove and
Archive Log Files

Strip Chart
Refresh

FIGURE 4-3.  TOOLBAR



4-5

Copy Selection:  Allows the user to copy one
or more data points, for use in another PCW
feature, like Strip Chart or Compare.

Remove and Archive Logs: Provides a short-
cut to a dialog used to purge and archive old
data from the log files.

Spawn Current View in New Window: Allows
the user to launch the right pane view into a
new window.

Refresh: Provides an immediate update of all
the parameter values for a connected device.

Strip Chart:  Launches the Strip Chart applica-
tion and brings up the default charting screen
for the connected device. (Refer to Section 9.)

Monitor:  Launches the Monitor application
and brings up the default Monitor screen for
the connected device.

Exit: Used to close the PCW program.

Help: Brings up the PCW online help file.

WARNING   Electrical shock and moving
parts can cause severe personal injury or
death. Notify personnel before starting a
generator set and before performing load
transfer on a transfer switch. Refer to the
equipment Operator’s Manual for impor-
tant safety precautions.

Genset Start/Genset Stop: When connected to
a genset control or an ATS , the toolbar ex-
pands to add a Genset Start and Genset Stop
button (Figure 4-4). Use this button to start or
stop a genset from PCW. The Genset Stop but-
ton will override a genset start signal from
PCW, but it will not override a remote start sig-
nal.

Notify personnel at the site, prior to using
this feature, so safety precautions can be
taken.

Genset
Start

Genset
Stop

FIGURE 4-4.  GENSET START/STOP
TOOLBAR BUTTON

Dialog Boxes
A dialog box is a window that requires infor-
mation from the user. Often, when you select a
function or menu option, the software will dis-
play a dialog box. You will then provide the re-
quired information by selecting an item from a
list, by clicking on an option button, or by en-
tering text. Several different dialog boxes are
used with PCW. The dialog boxes are de-
scribed throughout this manual.

The following rules will apply to all the dialog
boxes and system messages unless specified
otherwise.

• The Cancel button allows you to close and
exit a dialog box without saving any modi-
fications, and without executing any com-
mands.

• The OK button allows you to save any
changes made and/or execute a command
and close the dialog or message box.

All lists that the dialog boxes display are alpha-
betically sorted.

Mouse Menu Functions
In some Window views, clicking on he right
mouse button will bring up a menu command
related to that Window. (Some users change
the right and left mouse functions to their pref-
erences. The default settings for a two-button
mouse are left for select and right for menu.)
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NOTES
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5. Overview of Procedures

This section provides an overview of the pro-
cedures for using PCW. Detailed descriptions
of the features are described in the following
sections, beginning with Section 6 on Alarms.

OVERVIEW

The first four sections of this manual cover the
required setup steps and a basic description of
the software. This section covers the connec-
tions for both local and remote applications
along with basic operating procedures.

WARNING   Electrical shock and moving
parts can cause severe personal injury or
death. Notify personnel before starting a
generator set and before performing load
transfer on a transfer switch. Refer to the
equipment Operator’s Manual for impor-
tant safety precautions.

PCW can be used to monitor both local and re-
mote sites. There are site limitations with net-
work applications. Figure 5-1 show an exam-
ple of a monitoring setup with a combination
of network sites and non−network sites.

Non-Network Sites: PCW will monitor multi-
ple non-network remote and local sites.

Network Sites: PCW is limited to monitoring
one remote network site and one local network
site.

Combination Sites: PCW will monitor both
network and non-network sites. When this
combination exists a second modem and COM
port is required due to differences in the proto-
col between network sites and non-network
sites. Refer to Figure 5-1.

PCW
LNS 3.1

ModemSLTA

Modem 1

SLTA

Modem

Modem 2Local
Network

Remote
Network

Remote
Site

Local
Site

One or Many Sites

One or Many SitesLimited to One Site

Limited to One Site

Network Applications
(Protocol: Goal_Lon)

Serial Applications
(Protocol: Goal)

FIGURE 5-1. LOCAL AND REMOTE CONNECTIONS
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CONNECTIONS TO
INDIVIDUAL DEVICES

(NON-NETWORK
APPLICATIONS)

Connecting to a Genset

Local connection between the Monitoring PC
and the genset is made with a special RS-232
serial null-modem cable. The cable has a DB9
socket on each end. PCC 3100 requires a serial
communications kit for local and remote ap-

plications. Remote connections use standard
modem cables.

Figures 5-2 and 5-3 show two methods of con-
necting to a PCC 3200 genset.  The serial cable
from the service PC is connected to the cus-
tomer connection box. Figure 5-4 shows how
to connect to a PCC 2100 control and Figure
5-5 shows how to connect to a PCC 3100 con-
trol.

Special cable part numbers are shown for the
the following connection methods.

PCW
PowerCommand� Control

3200 Customer Connection Box

Null Modem Cable
DB9 to DB9 (338-3277)

Modem ModemREMOTE

LOCAL

Standard Modem
Cable

FIGURE 5-2. LOCAL AND REMOTE CONNECTION − PCC 3200 TYPE 1 CONNECTION BOX
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PCW

PowerCommand� Control 3200
Customer Connection Box

Null Modem Cable
DB9 to DB9
(338−3277)

Modem ModemREMOTE

LOCAL

Standard Modem
Cable

FIGURE 5-3. LOCAL AND REMOTE CONNECTION − PCC 3200 TYPE 2 CONNECTION BOX
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PCW

PowerCommand� Control
2100

Null Modem Cable
DB9 to DB9 (338-3277)

J9
Connector

LOCAL

FIGURE 5-4. LOCAL CONNECTION − PCC 2100

Connecting to a PCC 2100
Local connection to a PCC 2100 is shown in
Figure 5-4. Use a network connection for re-

mote monitoring (Figure 5-7). The PCC 2100
controls requires an FT-10 network to send re-
mote alarms.
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PowerCommand Control

Null Modem Cable
(DB9 to DB9
  338−3277)

Host Computer

Twisted Pair
(From Connection

Box TB1)

PowerCommand
Cable Interface

PowerCommand Control

Modem Cable
(DB9 to DB25
   338−3279)

Serial Cable
(DB25 to DB9)

Host Computer

PowerCommand
Cable Interface

Twisted Pair
(From Connection

Box TB1)

LOCAL

REMOTE

Modem

Modem

FIGURE 5-5. LOCAL AND REMOTE CONNECTION − PCC 3100

Connecting to a PCC 3100
Install the Serial Communications Kit
(300−5145) using the instructions and cables
provided with the kit.

Figure 5-5 shows the connection methods used
for both local and remote monitoring.
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Null Modem Cable
DB9 to DB9 (338-3277)

Digital
Module

PCW

LOCAL

FIGURE 5-6. LOCAL AND REMOTE CONNECTION − ATS APPLICATIONS

Connecting to an ATS

Local connection between the monitoring PC
and the ATS is made with a special RS-232 se-
rial null-modem cable. The cable has a DB9
socket on each end.

Use a network connection for remote monitor-
ing (Figure 5-7). PC-ATS controls requires an
FT-10 network to send remote alarms. Remote
connections use a standard modem cable.
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Modem
SLTA-10

FT-10 Network

GCM
(GenSet)

ATS

SLTA-10
FT-10 Network

GenSet ATS

PCW
LNS 3.1

Modem

PCW
LNS 3.1

LOCAL

REMOTE

Null Modem Cable

Standard Modem
Cable

Digital I/O Module

Digital I/O Module

FIGURE 5-7.  LOCAL AND REMOTE NETWORK CONNECTIONS

CONNECTIONS TO A LOCAL
OR REMOTE FT-10 NETWORK

In network applications the local connection
between the gateway and the monitoring PC is
made with a null-modem cable.

For remote network applications a standard
modem cable is used between the monitoring
PC and the modem. A null modem cable is
used between the gateway at the remote site
and the modem at the remote site.
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STARTING THE PCW
PROGRAM

Start PCW by selecting Programs from the
Start menu. Click on Power Generation and
then click on PCW. The programs in the PCW
program group will be displayed. Click on
Power Command, from within the PCW
group, to launch the PCW program and display
the Main Window (Figure 5-8).

If the System Administration feature is used
(Section 2), the level of user access is deter-
mined by their Windows logon. No passwords
are required by PCW to start the program or
open sites.

FIGURE 5-8.  PCW MAIN WINDOW

CONNECTING TO A SITE

After starting PCW, connect to the port (typi-
cally the site name created in Site Setup).
Double click on the port (or click on the port
[site] and then click on the Connect button, on
the toolbar).

FIGURE 5-9.  PCC CONTROL FEATURES

The device (or devices in network sites with
more than one device ) will be displayed in the
Device Explorer directory (Figure 5-9).
To monitor a device, connect to it by double
clicking on it (or click on the device and then
click on the Connect, from the Device menu).

For PCC genset and ATS controls, Device Ex-
plorer displays the features that are available in
the directory, listed under the device in the left
pane (Figure 5-9). These features are:

• Alarms
• Data Log
• Data Points
• Panel View
• Summary View

A brief description of each of these features is
provided here, and each subject is covered in
detail in the following sections.

Alarms
When the user starts PCW, and connects to a
Site, and a Device, the Alarm folder will ap-
pear below the device, in the Device Explorer
directory (Figure 6-1). The Alarms directory
contains a list of the alarms that have been re-
ceived by PCW from the device. For a detailed
description of this feature, refer to Section 6.
When the PCW program is open, it is not nec-
essary to connect to remote sites to receive
alarms. The program can be docked to the task
bar. When a remote alarm is sent to the moni-
toring PC an alarm popup will be displayed,
and the alarm will be annunciated and logged.
To create and view a custom report of logged
alarms, refer to Tools and Report, Section 13.

Data Log
When the user starts PCW, and connects to a
Site and a Device, the user will be able to start
logging data. (Data will only be logged while
PCW is connected to the device.)
Logged data can be viewed using the Data Log
(Report) feature (Figure 7-3). The report can
be created while you are connected to a device,
or at anytime using the reports feature.
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To view the report while you are connected to a
device, click on the Data Log folder, shown
below the device, in the Device Explorer direc-
tory, to launch the report in the right pane. The
Refresh button, on the toolbar, can be used to
update the report while you are connected to
the device. Refer to Data Log, Section 7, for
details on this feature.

If you are not connected to the device, you can
create a data log report from the Tools − View
Data Log menu pick. This feature allows you
to select the time period that you would like the
Data Log Report to cover, and it launches the
report in a new window. (Also see Tools and
Reports, Section 13).

Data Points
When the user starts PCW, and connects to a
Site, and a Device, the Data Points folder is
displayed below the device, in the Device Ex-
plorer directory (Figure 8-1). The Data Points
directory contains a list of preselected data
points, based on the device type.

Data Points will display current information
(updated approximately every second, net-
work application updates may take several sec-
onds between updates.)

Refer to Data Points, Section 8, for complete
details.

Panel View
When the user starts PCW, and connects to a
Site, and a Device, the Panel View folder is
displayed below the device, in the Device Ex-
plorer directory.
The Panel View feature provides a graphical
view of the device control panel. The view dis-
plays current information for the device being
monitored (updated approximately every sec-
ond, network application updates may take
several seconds between updates.)
Some of the buttons in the Panel View perform
functions when you click on them. These fea-
tures are described in detail in Panel View, Sec-
tion 9.

Summary View
When the user starts PCW, and connects to a
Site and a Device, the Summary View feature
will appear in the directory below the device,
in Device Explorer (Figure 10-1). The Sum-
mary View directory contains a list of pre-se-
lected parameters (based on device type).
The Summary View will display current in-
formation (updated approximately every sec-
ond, network application updates may take
several seconds between updates.)
Refer to Summary View, Section 10, for com-
plete details.

Tools and Reports
The Tools features include the Module Tem-
plate Editor used to add custom labels to the
DIM, CCM-G and CCM-T. The Tools menu
also allows the user to create reports from the
data log (View Data Log) alarm log (View
Alarm Log) and the journal (View Journal
Log).
Refer to Tools and Reports, Section 13, for ex-
amples of how to use these features.
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6. Alarms

ALARMS

PowerCommand for Windows can be used to
view the alarm history for a device and monitor
for alarm messages. Alarm messages that have
been received by PCW are logged, and a report
can be created from the Alarm Log.

This section describes how to view the alarms
that have been received by PCW, and how to
use the alarm notification feature for incoming
alarms. Refer to Section 13 for information on
creating an Alarm Report.

In order to receive an alarm from network ap-
plications, the Site Name, created in PCW’s
site setup must exactly match the network
name created for the network.

PCW will not share a phone line between
sites with networks (SLTA) and sites with-
out a network (Goal/RS−232). To receive
alarm messages, one modem and one phone
line will be needed for network applications
and one modem and one phone line will be
needed for sites without a network.

In all applications, only alarm messages that
have been configured with the PC service tool
to dial out, will be received.

VIEWING ALARMS

When the user starts PCW, and connects to a
Site, and a Device, the Alarm folder will ap-
pear below the device, in the Device Explorer
directory (Figure 6-1). The Alarms directory
contains a list of the alarms that have been re-
ceived by PCW from the device.

The Alarm view provides the following alarm
details:

Code: Alarm (fault code) identification num-
ber.

Level: This field displays the severity of the
alarm. The levels are None, Warning and Shut-
down.

Status: Indicates if the alarm is currently Ac-
tive, or if it is Inactive.

Site: Shows the Site Name where the device
being monitored is located.

Module: Shows the name of the device that is
being monitored.

Time Occurred: Provides the date and time
that the alarm condition first occurred.

User: Lists the user identification of the person
using PCW, to view the alarms.

Description: Provides a description of the
alarm.

FIGURE 6-1.  ALARMS
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The most recently received alarm is added at
the top of the list. Alarms received while the
Alarm directory is displayed, will appear in the
window immediately.

If this folder is empty, confirm that the network
was named properly and the site setup name
exactly matches the network name.

Alarm acknowledgement from PCW removes
the alarm from the PCW alarms received histo-
ry only. PCW does not acknowledge or remove
the alarm from the device.

RECEIVING ALARMS

The alarm notification feature launches when
PCW is started, and it closes when the PCW
session is ended. PCW displays an Alarms
popup message as soon as the message is re-
ceived.

Use the Windows menu drop-down list to set-
up PCW to annunciate incoming alarm mes-
sages and to display popup alarm message as
new alarms are received. Figure 6-2.

Select Annunciate Alarms, from the Win-
dows drop−down list to enable (checked) the
audible alert when a new unacknowledged
alarm is received.

FIGURE 6-2.  NOTIFICATION SETUP

Select Display Alarm Window, from the
Windows drop-down list, to enable (checked)
the Alarms Popup message when a new unac-
knowledged alarm is received.

Note: The network name (site ID) must con-
sist of no more than seven characters. The
characters can only be upper case letters,
numbers and underscores. Use of lower case
letters, special characters and spaces will
prevent PCW from recognizing dialed-in
alarms, from the site. Make sure the net-
work installer does not use lower case let-
ters, special characters, or spaces for the
network name.

Device names in network applications must
consist of no more than eight characters.
The characters can only be upper case let-
ters. Use of lower case letters, special char-
acters, numbers and spaces will prevent
PCW from recognizing device name in an
alarm message.
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Alarm Pop-up

When the Display Alarm Window feature is
enabled, the Alarm Pop-up message (Figure
6-3) is displayed each time a new alarm is re-
ceived.

PCW does not need to be connected to the site
to receive the alarm messages, but PCW pro-
gram does need to be open. To enable the PC to
receive remote alarms, refer to Enabling the
Monitoring PC to Receive Remote Alarms,
in Section 3.

The popup message provides the alarm code
(fault code number), site identification and de-
vice name (if named properly), date and time
of the alarm, and a description of the fault or
event.

After viewing the alarm, clicking on the OK
button to close the pop-up message until the
next time PCW receives an alarm message.

FIGURE 6-3.  ALARMS POP-UP
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7. Data Log

The Data Log feature allows the user to log
(record) a group of preselected data points and
view the logged data using the Data Log View
(Report) feature.

The user can also create a custom Monitor set-
up, for logging and viewing user selected data
points. (The Monitor feature is described in
Section 11.)

DATA LOG

The Data Log feature is used to record a group
of preselected data points. A view of the
logged data can be opened, from the Data Log
folder, in a Data Log Report. The data points
available are based on the device type. Data
must be logged before the data points can be
viewed. Using the logging feature is described
next, followed by a description of the Data Log
Report.

Logging and Managing Data

When the user starts PCW, and connects to a
Site and a Device, the user will be able to start
logging data for that device. (Data will only be
logged while PCW is connected to the device
and data logging has been stated.)

Start data logging by selecting Start Logging,
from the Device menu. The Logging Interval
dialog will be displayed (Figure 7-1).

FIGURE 7-1.  LOGGING INTERVAL

Select the desired logging interval between 1
and 240 minutes (in minutes or hours, up to 4
hours).

Some logging features are configured using
Setup. These include setting the logging path
(directory location where logged data is
stored) and related logging settings. Also in-
cluded in the Setup feature is a Disk Space Es-
timator. Review these settings and features de-
scribed in Section 2.

Logged data can be removed from the data log
directory by selecting Purge Logs, from the
File menu, or click on the Purge Logs icon, on
the toolbar. 

The Purge Logs dialog allows the user to re-
move data that is from 1 to 99 days old (Figure
7-2). Select the device that you wish to remove
the logged data from in the the Device Log(s)
list, then click on the Purge button. (Alarms
and Journal log files are covered in the Tools
section, 13.)

FIGURE 7-2.  PURGE LOGS
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VIEWING LOGGED DATA

Logged data can be viewed using the Data Log
Report feature (Figure 7-4). The report can be
created while you are connected to a device, or
at anytime.

To view the report while you are connected to a
device, click on the Data Log folder, listed be-
low the device, in the Device Explorer directo-
ry, to launch the report in the right pane. The
Refresh button, on the toolbar, can be used to
update the report while you are connected to
the device.

If you are not connected to the device, you can
create a data log report from the Tools − View
Data Log menu pick. This feature allows you
to select the site, select the device, and select
the time period that you would like the Data
Log Report to cover (Figure 7-3), and it
launches the report in a new window. (Also see
Tools, Section 13).

The Data Log Report displays data that is in
the data log for a specific device (data is only
logged while PCW is connected to a device,
and the logging feature has been started). The
report can be printed by using the Print and
Print Setup buttons.

The Data Log Report displays all of the pre-se-
lected data points (based on device type) at the

selected logging interval. The earliest logged
data is displayed at the top of the report.

A toolbar is added at the top of the report that
adds report navigation, details about the size of
the report, and report searching capability.

To search the report, enter the search criteria,
like a specific date, and click on the binoculars
icon, on the toolbar. The first occurrence of the
item being searched will be highlighted. Click-
ing on the binoculars again will bring up the
next occurrence.

FIGURE 7-3.  DATA LOG SETUP
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FIGURE 7-4.  DATA LOG REPORT (PCC 2100)



7-4

NOTES



8-1

8. Data Points

DATA POINTS

The Data Points feature allows the user to
monitor a group of preselected data points.
Each device type has its own group of prede-
fined data points.

The Data Points group includes measured val-
ues, switch or relay states, and text messages.
Some of the data points can be configured or
edited from PCW. This function would typi-
cally be performed by a service person as part
of a one-time setup procedure.

WARNING   Electrical shock and moving
parts can cause severe personal injury or
death. Notify personnel before starting a
generator set and before performing load
transfer on a transfer switch. Refer to the

equipment Operator’s Manual for impor-
tant safety precautions.

The user can select  individual data points from
the Data Points view to be logged or charted,
using the Monitor and Strip Chart features, de-
scribed in Sections 11 and 12.

Individual data points can also be compared
for a device, or between devices, using the
Compare feature, described later in this sec-
tion.

VIEWING DATA POINTS

When the user starts PCW, and connects to a
Site, and a Device, the Data Points folder is
displayed below the device, in the Device Ex-
plorer directory (Figure 8-1). The Data Points
directory contains a list of preselected data
points, based on the device type.

FIGURE 8-1.  DATA POINTS VIEW − PCC 2100
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FIGURE 8-2.  DATA POINTS VIEW − ATS

Data Points will display current information
(updated approximately every second, net-
work applications may take several seconds
between updates.)

The Data Points view provides the name of
the data point (Parameter), the current value,
the unit of measure being used (Units) and the
last time that the data point value was updated
(Time Last Read).

DATA POINT ADJUSTMENTS

Making adjustments would typically be per-
formed by a service person, as part of a one-
time setup procedure.

Located to the left of each data point is an icon
that indicates if the data point can be adjusted
(refer to Figure 8-2). The screwdriver icon in-
dicates that the data point can be changed
(written to) using PCW. The magnifying glass
indicates that the data point can only be moni-
tored (read only).

Each data point displays the current value and
the unit of measure for that value. Review this
information before making adjustments. Data
point value trims and settings are displayed.
Trims are numeric values that are entered di-
rectly into the Value cell. Settings are selected
from drop down lists, and they consist of sever-
al types of values such as On/Off and Enable/
Disable.
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To change a data point value, double click in-
side the Value cell of the data point that you
wish to change. The current value will be high-
lighted, if there are only a few choices, a drop−
down arrow will be displayed next to the Val-
ue.

If an arrow is displayed, click on the arrow to
view a drop-down list of the available settings.
Click on the desired setting, and it will be en-
tered into the Value cell.

If you do not see an arrow, begin typing the
new value, the new value entry will overwrite
the current value. If the value entered is above
or below the range of acceptable values, an er-
ror message dialog box will be displayed. Re-
view the information in the dialog box to see
the value limits, before clicking OK, to close

the error message dialog box.

Saving Adjustments

Edit Mode: When selected, a data point value
remains in the edit mode, as indicated by a
flashing cursor (numeric values) or the drop
down arrow (settings). When finished making
adjustments, press the enter key or click on
another parameter value to exit the edit mode.

Saving Adjustments: Adjustments are written
to the device as they are entered. To make these
changes permanent, click on the Device menu
and select Save Adjustments. Press the Reset
button, on the GLC LonWorks card (PCC
3200) or NCM (PCC 2100 or ATP-PC), to
download the new data from the base board to
the LonWorks card.
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COMPARE

The Compare feature is launched from within
the Data Points view. Click on the first data
point that you would like to compare, then use
the menu button on the pointing device (usual-
ly right mouse button) and select Compare,
from the popup menu (Figure 8-3).

The Compare Utility will launch and indicate
that 1 parameter has been selected, and identi-
fy the device it is associated with, Figure 8-4.

To add a datapoint to compare with the first
one, select the device, and then select the data-
point from the Data Points view. Drag-and-
drop (or Edit Copy and Paste) the data point to
the right window in the Compare Utility.

Click on the Compare toolbar icon to begin
comparing the two data points.

The View Errors Only filter is used when
comparing groups of data such as two similar
devices. This feature will list only the differ-
ences between the devices.

FIGURE 8-3. COMPARE FEATURE

Compa-
re View Errors

Only Pri-
nt Export

Data

FIGURE 8-4.  COMPARE UTILITY
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Print
Send to
File View Op-

tions

Print Set-
up

FIGURE 8-5.  COMPARE − PRINT

The data can be printed from a print dialog by
clicking on the Print button, on the toolbar.
The standard Windows print dialog is dis-
played.

Reports are designed to print on either Letter (8
1/2 by 11 inch) or A4 size sheets.

PCW does not support narrow or other non-
standard printers, including 32-column print-
ers.

Exporting Compare Data

Compare data can be sent to a file by using the
Export Data toolbar button. Click on the Ex-
port Data button, and the Save As dialog will
be displayed (Figure 8-6).

This window contains a Save as Type dialog
and a Save In dialog. Use the Save In drop-
down list to select the desired file format.

Enter the file name and select the drive and di-
rectory location for the file, then click the OK
button to start the the export process.

FIGURE 8-6.  COMPARE − EXPORT
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9. Panel View

PANEL VIEW

The Panel View feature provides a graphical
view of the device control panel. The view dis-
plays current information for the device being
monitored (updated approximately every sec-
ond, network applications may take several
seconds between updates.)

WARNING   Electrical shock and moving
parts can cause severe personal injury or
death. Notify personnel before starting a
generator set and before performing load
transfer on a transfer switch. Refer to the
equipment Operator’s Manual for impor-
tant safety precautions.

Some of the buttons in the Panel View perform
functions when you click on them. These fea-
tures are described in the following section.
Adjustment and calibration functions are not
available from the PC.

USING PANEL VIEW

When the user starts PCW, and connects to a
Site and a device, the Panel View folder is dis-
played below the device in the Device Ex-
plorer directory.
NOTE: Not all devices have a panel view.
Figures 9-1 through 9-4 show examples of
panel views. The PCC 2100, shown in Figure
9-1 provides similar features to the PCC 3200
and PCC 3100.

Manual
Run/Stop

Emergency StopAlphanumeric
Display

Fault
 Acknowledge

Reset

Off/Manual/Auto
Switch Position

 Indicator

Bar Graph

Status
Lamps

Previous
MenuMain Menu

FIGURE 9-1.  PANEL VIEW − PCC 2100
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Manual
Run/Stop

Emergency
Stop

Alphanumeric
Display

Fault
 Acknowledge

Reset

Off/Manual/Auto
Switch Position

Indicator

Bar Graph

Status
Lamps

Menu Navigation
Buttons

Exercise

Menu Navigation
Buttons

FIGURE 9-2.  PANEL VIEW − PCC 3200

Refer to the genset or ATS operator’s manual
for a full description of the control panel fea-
tures. The following provides a general de-
scription of the Panel View features for all of
the device types.

Alphanumeric Display:  The display simu-
lates the control panel display. The genset data
can be viewed using the navigation buttons
around the display. Click on the navigation ar-
rows to view the desired information.

Bar Graph:  Displays the current genset or
ATS metering information.

Off/Manual/Auto:  Display the current posi-
tion of the selector switch.

Manual Start/Stop:  Allows the user to re-
motely start or stop the genset. The selector
switch on the genset must be in the Auto posi-
tion. As a safety precaution, always notify per-
sonnel at the site before remotely operating the
genset.

Exercise (PCC 3200):  Performs the Exercise
function. Click on the Exercise to initiate a
genset exercise.  As a safety precaution, al-
ways notify personnel at the site before re-
motely operating the genset.
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Manual
Run/Stop

Emergency
Stop

Alphanumeric
Display

Run/Off/Auto
Switch

Position Indicator

Meters

Status
Lamp

Indicators

Fault Ack.
Reset

Menu Navigation
Buttons

FIGURE 9-3.  PANEL VIEW − PCC 3100

Emergency Stop:  Performs Emergency Stop
function. Click on the Emergency Stop button
to initiate the E-stop. The button displays the
word Stopped during an E-stop. The E-stop
must be removed at the site, click on the button
again after the E-stop has been cleared to reset
the button.

NOTE: Emergency Stop must be reset
(cleared) at the generator set. You cannot
reset an Emergency Stop from the monitor-
ing PC.

Fault Acknowledge Reset:  Allow the user to
acknowledge faults. When a fault occurs (and
is then corrected,) the Reset button allows you
to reset the module before restarting it.

Status Lamps:  Displays current status of each
of the fault indicator lamps.

Meters (PCC 3100):  Displays genset metering
information.

Run/Off/Auto (PCC 3100):  Display the cur-
rent position of the selector switch.
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Override

Alphanumeric
Display

Fault
 Acknowledge

Reset

Bar Graph

Status
Lamps

Test

Previous MenuMain Menu

FIGURE 9-4.  PANEL VIEW − OTPC

Test (ATS):  Performs the test function. Click
on the Test button to initiate a genset and trans-
fer switch test. As a safety precaution, always
notify personnel at the site before remotely op-

erating the genset.

Override (ATS):  Performs the override func-
tions. Click on the Override button to bypass
time delays.
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10. Summary View

This section describes the Summary View fea-
ture. This feature is used to monitor a group of
preselected data points for a device.

USING SUMMARY VIEW

When the user starts PCW, and connects to a
Site and a Device, the Summary View feature
will appear in the directory below the device,
in Device Explorer (Figure 10-1). The Sum-
mary View directory contains a list of pre-se-
lected parameters (based on device type).

Digital I/O Modules (DIM) and Controls
Communication Modules (CCM-G and CCM-
T) will display the summary view. The stan-
dard template will be used, or a custom tem-
plate can be created and applied to the device
(refer to Tools, Section 13). When a custom
template is created, the Summary View will
display the labels created in the custom tem-
plate.

When the user is connected to a device, the
Summary View will display current informa-

tion (updated approximately every second,
network applications may take several seconds
between updates.)

PCC 2100 Example

Figure 10-1 shows a group of preselected data
points for a genset with a PCC 2100 control.
When the Summary View directory is se-
lected, in the left pane, the device’s data points
appear in the right pane.

Each device type has a unique list of prese-
lected datapoints. The device in this example
(PCC 2100) has the following preselected pa-
rameter groups:

• Alternator Data
• Engine Data
• Control Status
The data in each of these groups is updated
when PCW connects to the device.  The data
continues to update along with the date and
time of the update, shown in the lower right
corner of the right pane.

FIGURE 10-1.  PCC2100 SUMMARY VIEW
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FIGURE 10-2.  OTPC SUMMARY VIEW

OTPC Transfer Switch Example

Figure 10-2 shows a group of preselected data
points for an OTPC transfer switch. When the
Summary View directory is selected, in the
left pane, the device’s data points appear in the

right pane.

Each device type has a unique list of prese-
lected datapoints. The device in this example
(OTPC) has the preselected parameter groups
shown in Figure 10-2.
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FIGURE 10-3.  CCM SUMMARY VIEW (CCM-T SHOWN)

DIMs and CCMs

Digital I/O Modules (DIM) and Controls
Communication Modules (CCM-G and CCM-
T) will display a Summary view. The view will
display the standard template or a custom tem-
plate if setup. A custom template can be
created and applied to the device (refer to
Tools, Section 13). When a custom template is
created, and applied to the device, the Sum-
mary View will display the labels created in the
custom template.

CCM-G and CCM-T Summary View
Example

Figure 10-3 shows the Summary View for a
Transfer Switch Control Communications
Module (CCM-T). When the Summary View
directory is selected, in the left pane, the de-
vice’s data points appear in the right pane. The
CCM-G Summary View shows the status of

the 32 discrete inputs, 8 relays and 10 analog
inputs.

Relays can be energized and de-energized by
clicking on the relay buttons in the summary
screen.

A symbol resembling a gray or red light indi-
cates the status of each relay and digital input.

• The energized (active) relays are displayed
with their respective status lights turned on
(Red).

• The de-energized (inactive) relays are dis-
played with their respective status lights
turned off (Gray).

• The active inputs are displayed with their
respective status lights turned on (Red).

• The inactive inputs are displayed with their
respective status lights turned off (Gray).

For a description of how to customize the mod-
ule labels, refer to Tools, Section 13.

The status for each relay and input is updated
when PCW connects to the device.  The status
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continues to update along with the date and
time of the update, shown in the lower right

corner of the right pane.

FIGURE 10-4.  DIGITAL I/O MODULE SUMMARY VIEW

Digital I/O Module Example

Figure 10-4 shows the Summary View for a
Digital I/O Module (DIM).

When the Summary View directory is se-
lected, in the left pane, the DIM module sum-
mary screen is displayed in the right pane.

The Summary View shows the status of the 8
standard relays, 8 optional relays (if equipped)
and the 8 customer inputs.

A symbol resembling a gray or red light indi-
cates the status of each relay and digital input.

• The energized (active) relays are displayed
with their respective status lights turned on
(Red).

• The de-energized (inactive) relays are dis-
played with their respective status lights
turned off (Gray).

• The active inputs are displayed with their
respective status lights turned on (Red).

• The inactive inputs are displayed with their
respective status lights turned off (Gray).

The labels for the module can be customized in
the Tools − Module Template Editor. For a
description of how to customize the module la-
bels, refer to Section 13.

The status for each relay and input is updated
when PCW connects to the device.  The status
continues to update along with the date and
time of the update, shown in the lower right
corner of the right pane.
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11. Monitor

This section describes how to use the Monitor
and Datalog features. There are two methods
of monitoring parameters, the user can create a
custom Monitor dialog for viewing selected
parameters, or the user can view pre-selected
parameters, based on the device type.

MONITOR AND DATALOG

The Monitor and Datalog features are used to
view and record (datalog) parameters. The
user can monitor preselected parameters with
Device Explorer, or they can select the specific
parameters they want to monitor and record,
using the Monitor Dialog feature.

PCW’s Device Explorer allows the user to nav-
igate and view preselected parameters. Refer
to the section named Using Monitor, for de-
tails.

MONITOR DIALOG

The Monitor Dialog allows the user to select
the parameters they want to view, set a sam-

pling rate and enable the data logging feature.
Sampling allows real-time data viewing. Data
logging stores information in a file for later
use.

The Monitor Dialog is displayed when the
Monitor command is launched from either the
Start menu or the Monitor button, on the
PCW toolbar.

Monitor Dialog Features

The Monitor Dialog is shown in Figure 11-1.
This section describes how to use the Monitor
Dialog features.

File Menu: Used to create a New Monitor file
or to Open an existing Monitor file. Also used
to Save changes to an opened file or Save As...,
to save changes to a new file. Recent allows
the user to view recently opened files and is
used as a shortcut to open a file.

Sample Rate
List Box

Sample
Enable
Check Box

Logging
Enable
Check
Box

Browse
Button

Datalog
File Name
Dialog
Box

Parameter
Information

Menu Bar

Toolbar

Generate 
Report Check Box

FIGURE 11-1.  MONITOR DIALOG FEATURES
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FIGURE 11-2.  TYPICAL MONITOR DIALOG

Edit Menu: Use the Edit menu commands to
Add, Delete, Edit, Cut, Copy, and Paste pa-
rameters into and out of the Monitor Dialog.

View Menu: Use the View command to hide or
display the Toolbar and Status Bar.

Help Menu: Provides PCW Help Topics and
About Monitor help.

Sampling: The Monitor dialog will sample at
the selected setting. To select the sample rate,
click on the Sampling − Enabled check box
(enabled when checked). Enabling the Sam-
pling feature activates the Sampling Rate list
box. Select the desired sampling rate from the
list box. Sample rates are available from 0.05
seconds to 60 seconds.

Logging: Logging allows the user to log pa-
rameter information to a .LOG file (at the se-
lected Sampling Rate). Sampling must be en-
abled to use this feature. Before enabling data
logging, enter a name in the file dialog. The log
file uses the tab delimited file format. To select
the Logging feature, click on the Logging −
Enabled check box (enabled when checked).
Enabling the Logging feature starts datalog-
ging. To stop data logging, disable the Log-
ging check box. Data can be logged to the de-
fault (Monitor.LOG) file. The Browse button

allows the user to locate and overwrite a .LOG
file in another directory. A report can be gener-
ated if you click on the Generate Report
check box.

Adding Parameters

Parameters can be added to the Monitor Dialog
by selecting Edit − Add from the Menu bar or
by clicking on the Add button, on the toolbar.
The Add command launches PCW. Use De-
vice Explorer to locate, select and copy the pa-
rameters that you want to add to the Monitor
dialog.

After selecting a parameter, use the drag-and-
drop procedure to add the parameter to the
Monitor Dialog. (Or use the right menu button
to Copy it, then move the cursor to the Monitor
Dialog and use the right menu button again to
Paste the parameter into the Monitor Dialog.)

Monitor settings can be saved to a template
(.TPL file). These files are saved in the Moni-
tor subdirectory of PCW. The template file
stores the COM port information, this prevents
the file from working on another COM port.

Each monitor screen provides the ability to log
sampled values into a tab delimited .LOG file.
This file format allows the data to be imported
into Microsoft Excel.
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12. Strip Chart

STRIP CHART

The Strip Chart feature displays data in a
graphical form on a real-time strip chart. Up to
six parameters can be displayed in one chart.
Data is scrolled from right to left, so the most
recent data appears at the right.

Chart parameters can be saved to chart file
(.TPL file), allowing the user to save custom
parameter selections and settings. The chart
file will store the charts graph settings (Y-axis
limits, sampling rate, line styles, etc.) and port
identification. A chart file can be used with
other ports. Chart files are saved in the Strip
Charts directory.

Data is not logged using the Strip Chart fea-
ture, refer to the Monitor section if data log-
ging is required.

Figure 12-1 shows a typical strip chart. Each of
the parameters contained in the chart are
named in the legend at the top of the chart.

The Y-Axis displays the range of each parame-
ter value. The Time that the sample was taken
for each interval is displayed at the bottom of
the chart.

Starting the Strip Chart Feature

The Strip Chart feature can be launched in two
ways:

1. Launch Chart from the Windows Start
−> All Programs menu, under the Pow-
er Generation −> PCW group shortcuts.

2. Start PowerCommand for Windows,
connect to a device, then click on the
Strip Chart button, on the toolbar.

Starting a strip chart from PowerCommand,
while connected to a device, allows PCW to
identify the device and display the correct strip
chart file type. This prevents accidentally
opening a strip chart file for the wrong device
type.

If the chart file does not exist, Strip Chart will
display the File-Open screen, with a listing of
chart files in the Strip Charts directory.

Y-Axis

Parameter

Legend

Menu Bar

Toolbar

FIGURE 12-1. TYPICAL STRIP CHART
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CREATING A CUSTOM STRIP
CHART

Strip charts can be customized by adding or de-
leting parameters, adjusting the sampling rate,
changing line styles, changing  the Y-axis lim-
its and making format changes.

The user can customize an existing strip chart,
or create a new strip chart and define each of its
properties. To create a new strip chart, launch
the Strip Chart feature from the Start -> All
Programs menu, without specifying any chart
file to open.

Adding Parameters

Click on Add Parameters, from the Edit
menu, to launch PCW. To add parameters to
the strip chart, drag individual parameters
from PCW (right pane) and drop the parameter
on the strip chart. Multiple parameter selec-
tions may be dragged and dropped on the Strip
Chart, to add several parameters at once. Pa-
rameters can also be added by selecting a pa-
rameter and using the Edit − Copy command
from PCW and the Edit − Paste command
from the Strip Chart menu bar.

Since parameters with different units of mea-
sure may be added to the graph, a separate Y-
axis will be displayed for each graphed param-
eter.

As parameters are added to the graph, an addi-
tional Y−axis will appear, indicating the pa-
rameter’s description and unit of measure. A
new legend item will appear at the top of the
graph, indicating the point shape and color that
will be used when plotting the parameter’s val-
ues, and these values will automatically begin
to be displayed.

Immediately after the first parameter is added
to the Strip Chart graph, the applet automati-
cally begins monitoring parameter values at
half-second intervals. The sampling rate may
be modified via the Options dialog, described
later in this section.

FIGURE 12-2.  PARAMETER PROPERTIES

Parameter Properties Dialog

The Parameter Properties dialog, shown in
Figure 12-2, is accessible from the Edit −
Properties menu.

The Name combo box, at the top of the dialog,
provides access to each of the parameters cur-
rently displayed on the Strip Chart. The user
may delete the selected parameter from the
strip chart by clicking on the Delete button.

The Data Ranges associated with the selected
parameter may be modified by entering new
values into the edit boxes.  These new values
will control the minimum and maximum data
values displayed on the Y-axis of the graph.

The Line Attributes may also be modified by
selecting a new line style from the Style combo
box.  A new line color may be selected by
clicking on the Color button, which invokes
the Windows common Color dialog. Current
changes are applied after the user clicks on the
OK button, to close the dialog.
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FIGURE 12-3.  SAMPLING RATE DIALOG

Sampling Rate Dialog

The Sampling rate feature is available from the
Strip Chart − Options menu. The Sampling
Rate dialog, shown in Figure 12-3, allows the
user to select the strip chart sampling rate.
Sampling can be enabled or disabled using the
Sampling Enable feature (see Strip Chart
Menu Bar Functions).

When finished customizing the strip chart,
choose the File−Save As... menu option.
Name the file and save in the Strip Charts di-
rectory.

Note: Saving a Custom Strip Chart saves
only the chart settings, it does not save (log)
data.

See Context Menu for additional commands
that are available for customizing strip charts.

Strip Chart Menu Bar Functions

This section describes each of the menu com-
mands that are available from the Strip Chart
menu bar.

File-Open: Allows the user to specify a partic-
ular chart (.TPL) file to load from the list of
chart files, in the Strip Chart directory. Logged
data (.LOG file) can also be opened and
viewed with the Strip Chart feature.

After a .TPL file has been selected, the applet
will open the file and load the parameters and
settings from that file. Since parameter values

will be graphed, only the first six parameters
that have numeric values will be accepted.

File- Save: Allows saving the current selec-
tion of parameters to a chart file.

File - Save As: Allows saving the current set of
parameters to a new chart file name and/or
location.

File-Close: Closes the Strip Chart

Edit-Add Parameter: Allows adding parame-
ters to the Strip Chart graph from PCW. This
command opens PCW, allowing the user to se-
lect parameters to be added to the Strip Chart.
Drag individual parameters from PCW and
drop the parameter on the Strip Chart graph.

Edit-Paste: Allows pasting the parameter(s)
from the Windows clipboard into the strip
chart. The Paste menu option will remain dis-
abled until one or more parameters have been
cut or copied to the Windows Clipboard.

Edit-Properties: Opens the Element Proper-
ties dialog. (This feature can also be activated
by double clicking on the parameter names in
the strip chart’s legend.) The Element Proper-
ties dialog allows the user to perform a variety
of commands relating to the display properties
of the Strip Chart.

Options-Sampling: This option displays the
Sampling Rate dialog, which allows the user
to change the strip chart sampling rate. The
sample rate is adjustable from 0.05 seconds to
60 seconds.

Options-Sampling Enable: This option is
used to enable or disable the collection of sam-
ple data. A check mark is displayed next to
Sampling Enable on the Options drop down
menu to indicate that the feature is enabled.
Click once on Sampling Enable to stop col-
lecting sample data. Click on it again to start
collecting sample data again.
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FIGURE 12-4.  CONTEXT MENU
FEATURES (RIGHT MENU BUTTON)

Context Menu Features

The Context Menu, shown in Figure 12-4,
may be accessed by clicking on the right
mouse button (or equivalent pointing device
button) while the cursor is inside the graph.
This set of menu items provides the users with
additional customization features.

Viewing Style: This  controls the viewing style
of the object.  Possible values include color,
monochrome, or monochrome with symbols.

Font Size: This controls the font size used in
the graph’s image creation process.  The font
sizes available are large, medium, or small.

Note: It is recommended that the user
change the Font Size to the Medium setting,
or Large setting if only a few parameters are
being monitored. This selection will make it
easier to read the parameter legends.
Numeric Precision: This controls the number
of decimal places associated with the graph’s
data. Possible values include zero, one, two or
three decimal places.

Data Shadows: This controls whether shad-
ows will be placed behind plotting method
graphics. The shadows add depth to the imag-
es; however, they will slow image creation sig-
nificantly when graphing many subsets and/or
points.

Grid Lines: This controls the horizontal and
vertical lines that make up the graphs grid. Pos-
sible values include horizontal and vertical
grid lines, horizontal grid lines only, vertical
grid lines only, or no grid lines.

Grid In Front: This controls whether the
graphs grid is placed behind or in front of the
plotting method graphics.

Graph and/or Table: This controls what is dis-
played in the graph’s area.  Possible values in-
clude graph, table, or graph with table.

What to Table: This controls what information
is included in the objects table.  Possible values
include tabling those subsets that are graphed
or tabling all subsets.

Point Label Orientation: This controls the ori-
entation of the point labels.  Possible values in-
clude automatic, horizontal, or vertical.

Mark Data Points: This controls whether
data-points are marked with a small circle.

Maximize: This function maximizes the graph
display. To return to the default display size,
click inside the solid bar at the top of the win-
dow or use the Esc key.

Customization Dialog: This function displays
the chart Customization dialog.

Export Dialog: Graphs can be exported in the
formats shown in Table 12-1, for the listed des-
tinations. This dialog allows the user to print a
Strip Chart (see Printing a Strip Chart, Figure
12-6).

TABLE 12-1. 

FORMAT DESTINATIONS

Metafile Clipboard, File, and
Printer

Bitmap Clipboard and File

OLE Object Clipboard

Text / Data Clipboard and File

Help: Displays graph-related help topics.
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FIGURE 12-5.  CHART CUSTOMIZATION
DIALOG

Chart Customization Dialog

An additional level of editing is available that
allows the user to customize the chart dialog.
To access this feature, double click within the
chart to display the Customization dialog.
This dialog has tabs for each of the editable
features.

Click on the desired tab to view the available
settings for that feature. These features can be
used to enhance the chart by changing border
colors, text size and colors, and many other
chart display features.

FIGURE 12-6.  EXPORT − PRINT DIALOG

Printing a Strip Chart

A Strip Chart can be printed by using the Ex-
port dialog (Figure 12-6). Use the right menu
button to access the Export Dialog, then select
the Printer radio button and select the Print
button.

Viewing Logged Data

Logged data, created with the Monitor feature
(refer to Monitor Section 6) can be displayed
with the Strip Chart feature. Select Open from
the Strip Chart File menu. Enter the .LOG file
location and name.

Strip Chart will display logged data. Since the
data is not being displayed on a real-time basis,
the data is static. Use the left and right arrow
buttons, located on the keyboard, to navigate
the data within the .LOG file.
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NOTES
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13. Tools and Reports

This section describes the features that are
available from the Tools menu drop-down list.
These features include the Module Template
Editor and View Data Logs, View Alarm Logs,
and View Journal Logs. Viewing the logs al-
lows the user to create a report to view specific
devices for a specific time period.

PCW does not need to be connected to a site to
use these tools. Module templates can be
created and reports can be viewed any time.

MODULE TEMPLATE EDITOR

This feature allows you to edit the labels for
Online Summary screens. These editable sum-
mary screens are called Module Templates.
Templates are created by selecting the module
type in the Module Template Editor, from the
Tools menu.

There is one Digital I/O Module (DIM) tem-
plate and two Controls Communications Mod-

ule templates (CCM-G for genset applications
and CCM-T for ATS applications).

You can customize the templates and give
them a unique name with the Save As feature.
A customized template can be used by more
than one device of the same type.

Open the desired template from the Tools
menu, select: Module Template Edi-
tor−>DIM Editor, or CCM-G Editor, or
CCM-T Editor.

The following section covers a typical tem-
plate for each application, beginning with the
DIM template. Figure 13-1 shows a new DIM
template.

If you wish to create a custom template, enter
whatever you want displayed in the fields. an
example is shown in Figure 13-2.

By selecting the DIM Default from the pull-
down menu, the default template is displayed
(see Figure 13-3).

FIGURE 13-1.   DIM ONLINE SUMMARY TEMPLATE DIALOG BOX
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FIGURE 13-2.   CUSTOMIZED DIM ONLINE SUMMARY TEMPLATE

FIGURE 13-3.   DEFAULT DIM ONLINE SUMMARY TEMPLATE

DIM Template

The DIM Template drop-down arrow is used
to access any previously created templates.
These templates can be removed (Delete), or
used to create new templates. The Clear but-

ton will remove all of the labels that have been
entered.

The OK button allows you to close the tem-
plate after viewing it. Cancel closes the tem-
plate without saving changes.
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The default DIM template is shown in Figure
13-3.

To create a new template, open a new (or exist-
ing) DIM template, enter the desired labels for
the 16 relays and 8 discrete inputs into each of
the edit boxes. (Example assumes expansion
relay board is included, otherwise use the first
eight relays). Use the tab key to move to the
next edit box (Figure 13-2).

When you are finished entering all of the de-
sired labels, click on the Save As button. A dia-
log will popup allowing you to enter the new
template name (Figure 13-4). Enter the new
template name and click on the OK button to
save the template.

FIGURE 13-4.  TEMPLATE NAME

Apply the changes to the DIM using the PCW
setup feature. A network site containing the
DIM will be needed (refer to Section 3).

Select the site from the Site List. Click on the
Device Setup button to view the Device List.
In this example, select the DIM (DIMB) from
the list (Figure 13-5).  Click on the Template
drop-down arrow and select the name of the
template to be applied to the device (in this ex-
ample the template was named NFPA 110).

Click on the OK buttons for the Create Device
and Device Setup dialogs, then click on Apply
to save the settings. Click on OK to complete
the setup and close the Site Setup dialog.

After applying the template to the device, con-
nect to the network site and the device. The
Summary View will display the customized
template.

FIGURE 13-5.  DIM DEVICE SETUP
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FIGURE 13-6.  CCM-G ONLINE TEMPLATES

CCM-G Template

The CCM-G Template drop-down arrow is
used to access any previously created tem-
plates. These templates can be removed (De-
lete), or used to create new templates.

The Reset button will return all of the labels to
the original settings.

The OK button allows you to close the tem-
plate after viewing it. Cancel closes the tem-
plate without saving changes.

To create a new template, open a new (or exist-
ing) CCM-G template, enter the desired labels
for the 16 discrete inputs (inputs 17 through 32
are already labeled), 10 analog inputs, and 8 re-
lays. Use the tab key move to the next edit box
(Figure 13-6).

When finished entering all of the desired la-
bels, click on the Save As button. A dialog will
popup allowing you to enter the new template
name. Enter the new template name and click
on the OK button to save the template.

Apply the changes to the CCM-G using the
PCW setup feature. A network site containing
the CCM-G will  be needed (refer to Section 3).

Select the site from the Site List. Click on the
Device Setup button to view the Device List.
In this example, select the CCM-G (CCMG)
from the list (Figure 13-7).  Click on the Tem-
plate drop-down arrow and select the name of
the template to be applied to the device (in this
example the template was named Genset B).

Click on the OK buttons for the Create Device
and Device Setup dialogs, then click on Apply
to save the settings. Click on OK to complete
the setup and close the Site Setup dialog.

After applying the template to the device, con-
nect to the network site and the device. The
Summary View will display the customized
template.

FIGURE 13-7.  CCM-G DEVICE SETUP
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FIGURE 13-8.  CCM-T ONLINE SUMMARY TEMPLATES

CCM-T Template

The CCM-T Template drop-down arrow is
used to access any previously created tem-
plates. These templates can be removed (De-
lete), or used to create new templates.

The Reset button will return all of the labels to
the original settings.

The OK button allows you to close the tem-
plate after viewing it. Cancel closes the tem-
plate without saving changes.

To create a new template, open a new (or exist-
ing) CCM-T template, enter the desired labels
for the 16 discrete inputs (inputs 1 through 16
are already labeled), 10 analog inputs, and 8 re-
lays. Use the tab key move to the next edit box
(Figure 13-8).

When finished entering all of the desired la-
bels, click on the Save As button. A dialog will
popup allowing you to enter the new template
name. Enter the new template name and click
on the OK button to save the template.

Apply the changes to the CCM-T using the
PCW setup feature. A network site containing
the CCM-T will  be needed (refer to Section 3).

Select the site from the Site List. Click on the
Device Setup button to view the Device List.
In this example, select the CCM-T (CCMT)
from the list (Figure 13-9).  Click on the Tem-
plate drop-down arrow and select the name of
the template to be applied to the device (in this
example the template was named OTIII).

Click on the OK buttons for the Create Device
and Device Setup dialogs, then click on Apply
to save the settings. Click on OK to complete
the setup and close the Site Setup dialog.

After applying the template to the device, con-
nect to the network site and the device. The
Summary View will display the customized
template.

FIGURE 13-9.  CCM-T DEVICE SETUP
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REPORTS

The Tools menu allows the user to create a cus-
tom report from the log files. Data is automati-
cally recorded in the Alarms Log when alarms
are received. The Journal log also is updated
automatically. It is important to note that the
Data Log information is only collected while
you are connected to the device, and the log-
ging feature is enabled (refer to section 7).

Data Log Report

To create a custom report form the Data Log,
select View Data Log from the Tools menu.

Select the Site and Device from the drop-down
arrow to create a report for a specific device
(Figure 13-10).

Next, select the date and time period that you
would like the report to cover, or click on the
Earliest and Latest check boxes to get a report
for all of the data on the selected device. Click
on the Create button, to create and launch the
report.

FIGURE 13-10.  DATA LOG REPORT

The Custom report is display in a new window
(Figure 13-11). The report can be navigated by
using the left and right arrow buttons on the
toolbar to page through the report. The report
can be printed by using the Print and Print Set-
up buttons.

The search tool (binoculars) can be used to find
a specific data point. Enter the search criteria in
the edit box next to the binoculars and click on
the Binocular button.

FIGURE 13-11.  CUSTOM DATA LOG REPORT
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Alarm Report

Each time an alarm is received from a device,
the alarm is recorded in the log file. To create a
custom report from the Alarms Log, select
View Alarm Log from the Tools menu.

Select the Site and Device from the drop-down
arrow to create a report for a specific device
(Figure 13-12).

Next, select the date and time period that you
would like the report to cover, or click on the
Earliest and Latest check boxes to get a report
for all of the data on the selected device. Click
on the Create button, to create and launch the
report.

The Custom report is display in a new window
(Figure 13-13). The report can be navigated by
using the left and right arrow buttons on the
toolbar to page through the report.

The search tool (binoculars) can be used to find
a specific alarm. Enter the search criteria in the

edit box next to the binoculars and click on the
Binocular button.

To view the Alarms Log (see Figure 13-14)
and print it, select File −> Print from the menu
bar when the Alarms Report is displayed. The
report can be printed by using the Print and
Print Setup buttons.

FIGURE 13-12.  ALARMS REPORT

FIGURE 13-13.  CUSTOM ALARMS REPORT
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FIGURE 13-14.  ALARMS LOG

Journal Report

Each time PCW is used a journal entry is
created in the log file. To create a custom report
from the Journal Log, select View Journal
Log from the Tools menu.

Select the date and time period that you would
like the report to cover, or click on the Earliest
and Latest check boxes to get a report for all of
the data in the Journal log (Figure 13-15).

Next,  Click on the Create button, to create and
launch the report.

The Custom report is display in a new window
(Figure 13-16). The report can be navigated by
using the left and right arrow buttons on the
toolbar to page through the report.

FIGURE 13-15.  JOURNAL REPORT

The search tool (binoculars) can be used to find
a specific journal entry. Enter the search crite-
ria in the edit box next to the binoculars and
click on the Binocular button.
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FIGURE 13-16.  CUSTOM JOURNAL REPORT
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14. Window Menu

Use the Window menu features to manage the
Device Explorer Window and to launch or hide
additional windows and features.

TOOLBAR AND STATUS BAR

The Toolbar and Status Bar are selected
(checked) by default. To remove them from the
Device Explorer window, click on them (un-
checked). To return these features to the De-
vice Explorer window, return to the Windows
menu and click on them again.

SPLIT

The Split feature allows the user to easily re-
size the left and right window panes. Drag the
active centerline between the left and right
pane to the preferred size.

MONITOR

Launches the Monitor dialog. Refer to the
Monitor Section for details on this feature.

STRIP CHART

Launches the Strip Chart feature. Refer to
the Strip Chart Section for details on this
feature.

VIEW IN SEPARATE WINDOW

(Window) View in Separate Window
launches a new window for the information
that is currently being displayed in the Device
Explorer right pane.

CASCADE WINDOWS

(Window)  Cascade is the standard Windows
function to cascade open windows (Figure
14-1). This feature stacks all open windows
that were launched from the Device Explorer
View In Separate Window feature. The win-
dows are stacked so that the title bars can be
read.

CLOSE ALL

(Window)  Close All closes all open windows
that were launched from the Device Explorer
View In Separate Window feature. This com-
mand closes open sites. From the Window
menu, select: Close All.

All remaining open windows are shown on
the Taskbar.

ANNUNCIATE ALARMS AND
DISPLAY ALARM WINDOW

Annunciate Alarms and Display Alarm
Window features are selected (checked) by
default. To disable alarm annunciation, click
on the the feature in the Windows menu to dis-
able it (unchecked).

To prevent the Alarm Window from automat-
ically popping up, whenever an alarm message
is received, click on Alarm Window in the
Window menu drop-down list (unchecked).

To restore these features, Go the the Windows
menu drop-down list and click on them again.
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FIGURE 14-1.  CASCADE WINDOWS



15-1

15. Paging

This feature is used to send event messages to
an alphanumeric  pager. Remote applications
will send event messages that are configured
for dialout. This feature requires WinBEEP 32
software on the monitoring PC.

PAGING APPLICATIONS
Figures 15-1 illustrates typical monitoring ap-
plications using the paging feature for both lo-
cal and remote installations. Refer to Figure
15-2 for local and remote network applica-
tions.

The PCC 3100 and PCC 3200 controls support
PCC serial communications for monitoring
without the use of an FT-10 network. PCC
2100 and PC-ATS require a network card to
send remote messages. All other devices
(CCM-G, CCM-T) must be monitored over an
FT-10 network.

Note: Devices that are installed in a network
with autobinding (self-installed networks)
cannot be monitored with PCW.

Remote Monitoring With Paging

PCC 3100/PCC 3200 Only

GenSet

Serial Null Modem Cable

Modem
Pager

Local Monitoring With Paging

WinBEEP 32
PCW

WinBEEP 32
PCW

Modem
Modem

Pager

PCC 3100/PCC 3200 Only

GenSet

FIGURE 15-1. TYPICAL PAGING APPLICATIONS
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SLTA-10 FT-10 Network

GCMCCM-G ATS

Local Monitoring of Multiple Network Devices with Paging

WinBEEP 32
PCW + LNS

Modem
Pager

Modem
SLTA-10 FT-10 Network

GCM ATS

Remote Monitoring of Multiple Network Devices with Paging

Modem

WinBEEP 32
PCW + LNS

Pager
CCM-G

FIGURE 15-2. TYPICAL PAGING APPLICATIONS WITH FT−10 NETWORK

Figure 15-2 illustrates typical network moni-
toring applications that include the use of the
paging feature.

The following section describes the necessary
setup procedures for WinBEEP 32 and PCW.

To configure the PCC 3100 to dialout out
events for remote paging, the network installer
should use the plug−in for this device (refer to
the FT−10 Network Installation and Operation
manual 900−0529).
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FIGURE 15-3.  WINBEEP MAIN WINDOW

WINBEEP SETUP

WinBEEP is a messaging program that is used
to send messages from your computer via a
modem to a pager. In this application, it will be
used to forward predefined event messages
from a device to an alphanumeric pager. This
program can also be used to keep a history of
the messages being sent and their status. Refer
to the WinBEEP User’s Guide for information
on these features.

Install WinBEEP 32 using the installation in-
structions provided with the program. Figure
15-3 shows the WinBEEP 32 main window,
with the Tools menu selected.

The following section covers the steps used to
configure the WinBEEP 32 program for use in
power generation paging applications.

Each of the following steps must be performed
before using the pager feature:

� Modem Setup
� Service Provider Setup
� Agents
� Send Options
� New Subscriber Setup
� Phone and Modem Options
� Addressing Message
� Network Applications
� PCW Site Setup for Paging
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FIGURE 15-4.  SERVICES − MODEM

Modem Setup
A modem must be installed and configured on
the computer for paging. Use the following
steps to setup the modem.

1. Launch WinBEEP 32 from the Pro-
grams menu. Click on the Tools menu
and select Services. Figure 15-3.

2. In the Configure Services widow (Fig-
ure 15-4), click on the Modems tab.

3. Locate the modem on the PC that will be
used to send messages, and click on the

checkbox next to it (Figure 15-4). When
it is selected, a check will appear in the
box. 
(If the modem you want to use is not on
the list, click on the Add button to use the
Windows install feature to add the mo-
dem.)

4. Click on the Apply button to make the
selection.

Proceed to Service Provider Setup.
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FIGURE 15-5.  SERVICES − CONNECTIONS

Service Provider Setup

The service provider is the service that delivers
messages to pagers. The service provider re-
ceives the massages sent by WinBEEP and for-
wards them to the subscriber(s). Use the fol-
lowing steps to setup the Service Provider.

1. Click on the Connections tab and then
click on the Add button. Figure 15-5.

2. In the Select Connection Type window,
select the Wireless Dial-Up Service, and
click on the OK button (Figure 15-6).

FIGURE 15-6.  CONNECTION TYPE
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4. The Add New Service Provider Wizard
window is displayed to help guide you
through the setup. Click on the Next but-
ton to proceed. Figure 15-7.

5. Enter the display name for the service
provider in the dialog box, up to 30 char-
acters. Enter the name of the pager ser-
vice provider being used.

6. Click on the drop-down arrow to select
the communication device (modem). Se-
lect the modem previously setup. Click
on the Next button to proceed. Figure
15-8. FIGURE 15-7.  ADD NEW SERVICE

PROVIDER WIZARD

FIGURE 15-8.  NEW SERVICE PROVIDER NAME
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FIGURE 15-9.  SERVICE PROVIDER PHONE SETTINGS

7. The next Service Provider Wizard win-
dow is used to enter the number of the
modem the service provider uses to route
messages to the pager. (This is not the
same as the pager number.) If you do not
know the number, contact the service
provider and request the number for the
modem that they use to route messages to
the pager.

8. Select the area code from the drop-down
list or enter it. Enter the telephone num-
ber, up to 30 characters. Dashes are not
needed.

9. Select the country code from the drop-
down list.

10. Select the service provider protocol from
the drop-down list. Use the TAP13 selec-
tion. Click on the Next button to proceed.
Figure 15-9.
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FIGURE 15-10.  SERVICE PROVIDED ADDED

11. The next window is displayed to confirm
that the service provider has been suc-
cessfully added. Click on the Finish but-
ton to proceed. Figure 15-10.

When the service provider has been success-
fully added, the program returns to the Config-
ure Services window.

You can select the newly created service pro-
vider from the list and view the properties  for
the service provider by clicking on the Proper-
ties button.  In this setup we are going to use the
default settings. You can also delete service
providers from this screen. Figure 15-11.

FIGURE 15-11.  SERVICE PROVIDED LISTED
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FIGURE 15-12.  AGENTS

Agents

A new ASCII agent will be created and used
for this application. The ASCII agent enables
applications that can create an ASCII text file.
The ACSII agent was installed with WinBEEP,
but it needs to be added, configured and se-
lected as the agent.

1. Click on the Agents tab, then click on the
Add button, to add the new agent. Figure
15-12.

2. Select the ASCII Agent from the
Installed Agents list and click on the OK
button to proceed. Figure 15-13.

FIGURE 15-13.  ADDING AGENT
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FIGURE 15-14.  ASCII AGENT NAME

3. Enter a name for the this agent “ASCII”
and a description “Message Poll.” Then
click on the Next button. Figure 15-14.

4. Enter the Polling interval, in half minute
increments. This interval determines
how often the agent checks the directory
for new files to send. Figure 15-15.

5. Create an ASCII folder in a suitable drive

and location. This will be used to store
saved messages. Enter the path and direc-
tory to the newly created ASCII folder or
use the browse (...) button to locate and
select the directory location. This direc-
tory specifies the location of the saved
files. Click on the Finish button to com-
plete this setup.

FIGURE 15-15.  ASCII AGENT SETUP
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FIGURE 15-16.  SELECTING THE NEW ASCII AGENT

6. Make sure the checkbox next to the
ASCII agent is selected, to enable this as
the agent used with WinBEEP 32.

7. Click on the OK button, to complete this
setup.
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FIGURE 15-17.  SEND OPTIONS

Send Options

The Options feature allows you to add a name
to all outgoing messages. This feature also al-
lows you to set the retry count, create a log file,
and configure the History folder.

1. Select Tools−Options from menu bar.

2. Enter the Name (typically the site name,
or the network name for the site). Figure
15-17.

3. Set the Retry Options  using the arrows to
select the number of retries and the inter-
val between retries in seconds.

4. Set the Log Options by specifying the
Log File path. Enter the path or click on

the Log File button to browse to the file
or create a new one. Use the Maximum
setting (default setting) for the log detail.

5. Use the arrows to set the number of days
to store messages in the history folder.

6. The Clear All Messages button can be
used to clear messages from the History
folder. The View Status button can be
used to view the status on messages that
have been sent.

7. When finished setting the send options,
click on the Apply button, then click on
the OK button.
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FIGURE 15-18.  NEW SUBSCRIBER WIZARD

New Subscriber Setup

Create a new subscriber using the Subscriber
Wizard. The subscriber is the person who will
receive the messages on their pager. A number
of subscribers can be combined in a subscriber
group. Refer to the WinBEEP instructions for
creating and using Subscriber Groups.

1. Select File−New Subscriber from the
menu bar to launch the New Subscriber
Wizard. Click on the Next button to pro-
ceed. Figure 15-18.

2 Select the Wireless dailup address but-
ton. Then click on the Next button. Fig-
ure 15-19.

FIGURE 15-19.  ADDRESS TYPE
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FIGURE 15-20.  DISPLAY NAME AND PIN OR PAGER NUMBER

3 Enter the Display name (typically the
name of the person receiving the page) up
to 30 characters. This name will be used
in the personal address book.

4. For toll-free nation wide pagers, enter the

PIN (subscriber’s personal identification
number). 
For local pagers, enter the pager number
(pager ID). Do not use dashes in this
number. Then click on the Next button.
Figure 15-20.
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FIGURE 15-21.  SERVICE PROVIDER SETUP

5 Select the upper button for sending a
message using a predefined service pro-
vider...  Figure 15-21.

6. Select the service provider from the
drop-down list (select the service provid-
er that was previously setup). Then click
on the Next button.

7. At the last New Subscriber window, click
on the Finish button.  Figure 15-22.

8. When the Subscriber added successfully
popup message appears, click on the OK
button, to complete the new subscriber
setup.

FIGURE 15-22.  CUSTOM JOURNAL REPORT
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FIGURE 15-23.  SUBSCRIBER VIEW

When the subscriber has been added success-
fully, the new subscriber will appear in the
main window. Figure 15-23. If you do not see
the Subscribers list, select Subscribers from
the View menu.

Phone and Modem Options

The phone and modem options are configured
using the Windows  Control Panel feature.

Click on the Start menu, and then click on Set-
tings − Control Panel.

1. Double click on the Phone and Modem
Options feature.

2. With the Dialing Rules tab selected,
click on the NEW button to name and
configure the location that you will send
the pages from. Figure 15-24.

FIGURE 15-24.  PHONE AND MODEM OPTIONS − LOCATION



15-17

FIGURE 15-25.  EDIT LOCATION

3. Enter the Location name, Country/re-
gion, Area Code and any necessary pre-
fixes, if needed to access an outside line.
Select the dial type, then click on the Ap-
ply button. Figure 15-25.

4. Click on the Area Code Rules tab and
then click on the NEW button. Figure
15-26.

FIGURE 15-26.  CUSTOM JOURNAL REPORT
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FIGURE 15-27.  AREA CODE RULE

5. Enter the area code for the  number you
are sending the page to (subscriber). Fig-
ure 15-27.

6. You can also specify the prefixes to be
used within the area code or click on the
Include all... button.

7. Click on the OK button. The area codes
selected will be displayed. Use the Edit
button to make any necessary changes.
Figure 15-28.

 

FIGURE 15-28.  CUSTOM JOURNAL REPORT
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FIGURE 15-29.  CALLING CARD

8. Click on the Calling Card tab. This fea-
ture is used if a calling card will be used
for the phone service. In most applica-
tions this will be None (default). Click on
OK if your are using none or configure
the calling card information as needed.

Return to the WinBEEP program to complete
the next phase of the setup.
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FIGURE 15-30.  PERSONAL ADDRESS BOOK

Addressing Message
The last step with WinBEEP is to address the
message to the subscriber.

1. From the main WinBEEP window, click
on the To button, shown under Message,
on the left side (Figure 15-3).  This will
launch the Select Names dialog. Figure
15-30.

2. Click on the name of the person you want
to send the message to. Then click on the
To button, to add them to the Message
Recipients list.

3. Click on the OK button when you are fin-
ished addressing your messages. To save
the changes, click on the File menu in the
WinBEEP window, then click on Save.

Network Applications

A copy of the network database is required,
this should be provided by the network install-
er.   Follow the instructions provided in Section
3, for Importing The Network Site Database.
Then follow the next set of instructions in Sec-
tion 3, Prepare the Network Site Database File
for PCWII.

When the network site database has been im-
ported and registered, proceed to the following
section on PCW Site Setup for Paging.
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FIGURE 15-31.  PAGING SETUP

PCW Site Setup for Paging

Use the Setup features in PCW to create the site
and configure the communications. Follow the
instructions in Section 2 for non-network sites,
and Section 3 for network sites.

After the site has been created (or registered
and created for network sites), click on the
Paging tab. Figure 15-31. Setup the paging
feature as follows:

1. Enter the subscriber name in the Sub-
scriber Name List dialog box. Use the
WinBEEP subscriber name. Click on the
Add button, located on the right side of
the Paging window, to add the name to
the Subscriber Name list.

2. Select the site that you want to send mes-
sages from, in the Site List.

3. Select the subscriber name, added in step
1, then click on the center Add button.
Messages from the selected site will be
forwarded to the subscribed listed in the
Paging List.

4. Enter, or browse to and select the polling
directory created earlier in this section,
under Agents.

5. Accept the default values for the Max.
Message Length and Max. Subscribers
(recommended) or adjust the values as
needed.

6. Click on the Apply button, to save these
settings. Then click on the OK button to
close the setup program.

7. For network applications, follow the in-
structions in Section 3 for Gateway
installation, setup and alarm settings.

This completes the steps needed to enable the
monitoring PC to send messages to a pager.

Using the Pager Feature

To check the pager feature, launch PCW and
connect to the site. Create a fault (in remote ap-
plications, use a fault that is known to be con-
figured to dialout). Refer to Section 6, Alarms,
for information on receiving alarms.

When the message is received by PCW, the
message should be routed to subscriber’s pag-
er.

If the message is not sent, check the polling di-
rectory (ASCII folder) to see if the message
was recorded. If the message was recorded,
check the pager, the WinBEEP settings, and
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the PCW setup. In network applications, check
the network connection, using LinkManager
and check the gateway and alarm settings de-
scribed in Section 3, Network Applications.

If the message was not recorded, check the
polling directory path WinBEEP Agent set-
tings and PCW Paging setup.
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16. Help

Use the Help menu to find information about
using PowerCommand for Windows, to find
Service and Support information, and to find
out about the installed product type and soft-
ware version.

HOW TO USE HELP

The Help - How to Use Help feature displays
the standard Windows Help Topics dialog.
Use this feature to find answers to basic Win-
dows operation questions. Access this infor-
mation by clicking on the the Help menu, and
then click on How to Use Help.

HELP CONTENTS

The Help Contents feature provides access to
the list of subjects in the PowerCommand help
file (standard Windows Help format). Access
this information by clicking on the the Help
menu and then clicking on Contents.

SEARCH FOR HELP ON...

The Help - Search for Help On... feature al-
lows searching for help on a specific topic or
keyword (standard Windows Help format).
Access this feature by clicking on the Help
menu, then click on Search for Help On... .

ABOUT DEVICE EXPLORER

The Help - About... feature initiates the About
Device Explorer box (Figure 16-1). This box
displays the product type and software version.
To view this information, click on the Help
menu, then click on About Device Explorer.

FIGURE 16-1.  HELP − ABOUT



16-2

NOTES
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A.  PCW Legacy Software Removal

This appendix describes the uninstall pro-
cedures for removing PCW versions 2.0,
2.5, 4.0, 4.5, 5.0, or 5.5.

When installing PCW 6.0 on a PC that cur-
rently has an older PCW version  installed,
the following procedures must be fol-
lowed.

Earlier versions of PCW MUST be unins-
talled using the PCW version 6.0 installa-
tion program. Removal of legacy PCW pro-
grams by other means can prevent PCW 6.0
from installing.

LEGACY PCW REMOVAL

Failure to log on to the PC with the system
security feature enabled will prevent PCW
from installing properly. If your PC sys-
tem security is enabled and you selected
Cancel during the start up Logon, you
must restart your PC and enter the re-
quired logon information.

Close all other programs, including the
Microsoft Office shortcut bar. Close any

programs that have been docked to the
taskbar.

During installation, popup messages may
be displayed behind an open window. If
the install program is not responding,
check the taskbar, or press the Alt−Tab
keys to display hidden windows. Review
and close any popup messages.

To remove legacy PCW software ver-
sions:

6. Insert the PCW 6.0 CD into the PC.

7. After a short delay the program will
begin and launch the Install Shield
Wizard. 
(If the program does not autostart, se-
lect Run from the taskbar Start
menu. At the prompt, type D:\Setup
[substitute the drive letter of the CD
drive being used, in place of D] and
then click on the OK button.)

8. Click on the Start Installation but-
ton to begin. Figure A-1.

FIGURE A-1.  START INSTALLATION
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FIGURE A-2.  REMOVE PREVIOUS
VERSIONS

9. The program will begin and go
through a series of checks and prepa-
ration for the installation. 

The message in Figure A-2 is dis-
played when the install program de-
tects an earlier version of PCW. Click
on the Yes button to begin to uninstall

the previous version of PCW. 
Note: You must use this PCW ver-
sion 6.0 install program to remove
older PCW versions from powers-
wept PCs.

10. To uninstall PCW version 2.5 pro-
ceed to step 6. To uninstall PCW ver-
sion 2.0 proceed to step 10.

PCW Version 2.5 Removal

11. When the CPG PC Tools Installer
window is displayed, select Power-
Command the Products list, and then
click on the Uninstall button. Figure
A-3.

FIGURE A-3.  CPG GROUP UNINSTALLER
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FIGURE A-4.  UNINSTALL − ALL FEATURES

12. When the Program Maintenance
window is displayed, confirm that
the Uninstall all installed features
button is selected, then click on the

Next button. Figure A-4. (The Resto-
re Service Files feature is not used
with Uninstall.)
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FIGURE A-5.  UNINSTALL CONFIRMATION

13. At the Uninstall the Program win-
dow, click on the Uninstall button to
continue with the uninstall. Figure
A-5.
The Back button is used to review
your choice in step 7.

14. Monitor the text in the Output box,
when the text reads uninstalled suc-
cessfully, click on the Exit button.
Figure A-6.
Proceed to step 15.

FIGURE A-6.  UNINSTALL COMPLETE
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PCW Version 2.0 Removal

FIGURE A-7.  UNINSTALL REMINDER

15. When the Unistall window is dis-
played reminding the user to make

sure that other applications are not
running, click on the OK button. Fig-
ure A-7.
Close all other applications before
proceeding.

16. When the CPG Uninstaller window
is displayed, select PowerCommand
from the Products list, and then click
on the Uninstall button. Figure A-8.

FIGURE A-8.  CPG GROUP UNINSTALLER



A-6

FIGURE A-9.  ARE YOU SURE

17. When prompted with the message
Are you sure, click on the Yes button
to continue removal of PCW version
2.0. Figure A-9.

18. Monitor the text in the Output box,
when the text reads Done. Nothing to
Uninstall, click on the Close button.
Figure A-10.

FIGURE A-10.  UNINSTALL CONFIRMATION
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FIGURE A-11.  REBOOT MESSAGE

19. When prompted with the Reboot is

not necessary message, click on the
OK button to continue removal of
PCW version 2.0. Figure A-11.

20. To continue with the PCW 6.0 instal-
lation, return to PCW Installation in
Section 2, step 5. 
To discontinue the install program
click on the Cancel button. Figure
B−12.

FIGURE A-12. INSTALL PCW
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